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Introduction 
 

Scanning Probe Microscope (SPM) is a powerful experimental equipment, make use of which 

hyperfine structure and fine-scale physical properties of natural objects and artificial objects such 

as inorganic crystal surfaces, fine structure of a semiconductor, and biological nanostructure of 

organic molecules, self-assembled monolayers, protein molecules, DNAs, and so on , can be 

measured and functional development of them can be led. 

 Yet analysis of experimental results needs theoretical support because in the nano-range between 

a tip and samples mechanical, electronic and chemical process of atomic-scale are complicatedly 

entangled. 

 

This software was developed in order to satisfy such necessity. 

 Based on SPM simulator technology of current research level, some simulators are prepared and 

can be selected in order to reduce calculation scale according to the problem. 

 In addition GUI (Graphical User Interface) is equipped to be operated easily. 

From now on measuring technique of SPM will increase importance not only in the frontiers of 

basic research fields such as physical chemistry, life science, electronics ,information engineering 

and materials science but also in industrial fields such as semiconductor device, surface treatment 

technology, polymer material, bio-science, agriculture, advanced medicine, environmental catalyst, 

fuel cell, detergent and cosmetics industry. We are pleased if this software will help you as a 

research instrument in these fields. 

 

This book is an operations manual of the SPM simulator of our company, and installation of the 

software, operating procedures and attentions are described. There are explanations focusing on 

fundamental operation methods in this book so that even the beginners can use the software easily. 

For further settings, please refer to another attached document "reference manual". 
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Composition of SPM simulator 
 

 

The SPM simulator of our company has roughly five functions. 

 

1. Geometrical Mutual AFM Simulator 

2. Finite Element Method AFM simulator 

3. Soft Material Liquid AFM Simulator 

4. Classical Force Field AFM Simulator 

5. Quantum Mechanical SPM Simulator 

 

In addition, the SPM simulator provides an assistant function, the sample structure modeling tool. 

The five functions above consist of the following six simulators. 

 

① GEO  ② FEM  ③ LIQ  ④ CG  ⑤ MD  ⑥ DFTB 

 

The classification, the functional overview and the target area of each simulator are described in 

the following tables. 

 

table 1: the functional overview of each simulator 

 

simulat

or name
overview

Geometrical Mutual AFM Simulator GEO The simulator which in the three kinds of data, tip shape, sample shape and AFM image, predicts 
one kind of data from the other two kinds of data with high speed.

(In the calculation, data are mutually predicted by purely geometric calculation under the 
assumption that the tip-sample interaction is not counted, and the three-dimensional form of a tip 
and samples is not deformed.)

Elastic Body AFM Simulator FEM The simulator which predicts a AFM image under the assumption that van der Waals force 
between a tip and samples is counted on the base of classical mechanics, and in addition a tip and 
samples are subjected to the elasticity equation.

(Tip shape and sample shape are inputted, and AFM image is predicted and outputted.)

Soft Material Liquid AFM Simulator LIQ The simulator which calculates the movement of a cantilever in a liquid, in consideration of the 
drag from fluid and samples and the elastic deformation of the lever itself.

Classical Force Field AFM Simulator The simulator which calculates tip-sample interaction and predicts AFM image by using a force 
field based on classical mechanics.

geometry optimizing AFM image 
simulator

CG The simulator which predicts AFM image in consideration of deformation of samples based on 
energy relaxation method.

molecular dynamics AFM image 
simulator

MD MD The simulator which predicts AFM image in consideration of deformation of samples based 
on molecular dynamics method.

Quantum Dynamics SPM Simulator DFTB The simulator which predicts the AFM image/STM image/KPFM image by the method of 
calculating the electronic state of a system based on quantum mechanics and calculating tip-
sample interaction.

AFM image simulation The function which predicts AFM image by calculating chemical interaction.

STM image simulation  The function which predicts STM image by calculating tunneling current.

KPFM image simulation The function which predicts KPFM image by calculating contact potential difference.
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table 2: overview of the assistant functions 

 

 

 

table 3: the target area of each simulator 

 

○：both trial version and release version cover this region 

●：only release version covers this region 

－：neither covers this region 

overview remarks

function of predicting sample surface 
structure 

The function which compare a obtained image and simulated 
images, and predicts structure of samples from similar ones. 

under development

modeling function Creating initial structure.

semiconductor thin film modeling Creating and editing semiconductor thin film models from crystal 
structure data.

to be distributed attached to 
the trial version 

molecular modeling Creating and editing molecule structure. using external software 

protein modeling Using a protein data bank. using external software 

simulator 
name

object scale environment samples remarks

macro-
scale

micro-
scale

vacuu
m

liquid

Geometrical Mutual AFM Simulator GEO
○ － ○ －

nanoscale
semiconductor 
devices, 
(bio)polymer 
compounds

calculation can be made in one 
second

Elastic Body AFM Simulator FEM ○ － ○ －
deformation of a tip and samples 
can be considered

Soft Material Liquid AFM Simulator LIQ
○ － ○ ○

polymer, 
biomolecule etc.

Classical 
Force Field 
AFM 
Simulator

geometry optimizing AFM 
image simulator

CG
－ ○ ○ ●

organic small 
molecules, 
inorganic materials 
etc.

deformation of samples can be 
considered

molecular dynamics AFM 
image simulator

MD
－ ○ ○ ●

deformation of samples can be 
considered

temperature can be considered

Quantum 
Dynamics 
SPM 
Simulator

AFM image simulation DFTB
－ ○ ○ －

STM image simulation
－ ○ ○ －

KPFM image simulation
● ○ ○ －
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  Geometrical Mutual AFM simulator                                         

Geometrical and tip-sample-image 

interactive AFM simulator (GeoAFM) 

provides users with a kind of a three-way 

data processor. Among three geometrical 

elements, a tip, sample material and its 

AFM image, this module reconstructs the 

one out of the other two. For example, it 

can reconstruct the AFM image from 

information about shapes of the tip and 

the sample material. The GeoAFM 

accomplishes the calculation very rapidly, 

and it takes only a few seconds. A characteristic of this module is the fact that the GeoAFM can only 

sort out geometrical data and it neglects many physical properties of the tip and the sample 

material, Poisson’s ratios, Young’s moduli and the Hamaker constants. This module assumes that 

the tip always scans the surface of the material in the so-called contact mode. 

 

 

  Finite Element Method AFM simulator                                       

Finite Element Method AFM 

simulator (FemAFM) carries out 

numerical calculations for 

obtaining an AFM surface image 

according to the classical theory of 

elasticity and the Lennard-Jones 

potential. The FemAFM solves the 

differential equation for the theory 

of the elasticity with the finite 

element method, so that it never 

regenerates quantum effects. This 

module assumes that a tip put at the top of a cantilever always scans the surface of the material in 

the so-called non-contact mode, and the distance between the tip and the surface of the sample is 

equal to around a few angstroms. 
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  Soft Material Liquid AFM Simulator                                          

Soft Material Liquid AFM Simulator corresponds to dynamic AFM in liquid, and can simulate 

vibration analysis of cantilever and measuring visco-elastic soft material with SPM. The simulator 

calculates movement of the cantilever with coupling 

three forces, a drag acted from surrounding fluid, a 

contact force from samples and an elastic deformation 

of a lever itself. This simulator can calculate (under 

development) an AFM image of visco-elastic samples as 

a vibration mode, and can guess physical property such 

as an elastic modulus of a sample. Moreover resonance 

frequency of the cantilever in liquid is determined and 

vibration characteristics are found out, so that these are helpful for designing a shape of a 

cantilever and considering vibration conditions. 

 

 

  Classical Force Field AFM Simulator                                          

Classical Force Field AFM Simulator is a simulator 

which predicts AFM image with the arrangement 

that the simulator sets up force field parameters 

to each atom of target AFM samples, and 

calculates tip-sample interaction based on it. And 

this simulator has a feature in the ability to predict 

structural change of sample molecules by 

interaction from a tip with an atom scale. This 

simulator has two types of method to calculate molecule structure. One is a "geometry optimizing 

AFM image simulator" which explores stable atomic arrangement of molecule energy, and 

determines molecular structure. The other is a "molecular dynamics AFM image simulator" which 

predicts changing process of molecular structure by solving Newton's equation of motion about all 

atoms. Either can be selected according to the purpose, and simulation can be done. 

 

 

  Quantum Mechanical SPM Simulator                                         

The Quantum Mechanical SPM Simulator, based on quantum mechanical calculation of an 

electronic state, can simulate images of a frequency shift, a tunneling current and a local contact 

potential difference about microscopic surface structures in vacuum. Also the scanning tunneling 

spectroscopy can be analyzed as an application of the tunneling current calculation. This simulation 
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adopts the tight binding calculation method based on 

the density functional theory, so that the simulation 

reduces a large calculation cost which is usually 

accompanied with quantum calculation. Therefore a 

realistic scale sample surfaces to compare with an 

experiment and comparatively large systems estimated 

by classical molecular dynamics method can be 

calculated. 

 

 

  Modeling Tool                                                           

Thin film modeling tool, one of the assistant 

functions, creates initial structures of a tip and a 

sample surface loaded by the SPM simulator. This tool 

makes atomic models used on the microscopic 

methods such as DFTB, CG and MD. But in some cases, 

the created models may also be used on the 

macroscopic methods. This tool is good at preparing a 

thin film model with an ideal surface. In addition, any 

atom or atomic cluster can be added, deleted, transferred and changed.  
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Chapter 1 

Installation of the software and preparation 
 

 

 

1  installation of the software 

 

 

We have distributed a free trial version of the SPM simulator since June 28, 2011. You can obtain a 

free trial version by requesting from the URL below. 

  URL for requesting a free trial version of the SPM simulator 

    https://www.aasri.jp/pub/spm/en/about_spm_12_eng.html 

 

The application form is as follows. 

 

 

         
・ 

Input basic information of you. 
Select the simulators you want. 

1 installation of the software 

https://www.aasri.jp/pub/spm/en/about_spm_12_eng.html
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・ 
・ 

 

 

 

 

After your application is accepted, you will soon receive an e-mail with an account ID, a license key and 

download URL. 

 

 

Download an installer named "SPMInstaller.zip" and save it to your computer.  

 

 

 

Input the above and submit. 
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Unzip SPMInstaller.zip. 

 
 

 

When unzipped, a folder named SPMInstaller is created. Open the folder. 

 



 14 

Double-click the Installer.exe to run. 

You will see the following screen. 

 
 

Then the next screen is shown. Click the “Next” button to continue. 
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A software license agreement is shown. Read it and continue installing if you agree. 

 

 
 

When you check the “I accept the terms”, then the “Next” button gets enabled. Click the “Next” 

button to continue. 
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In the next screen, input the account ID and the license key received from e-mail, and click “OK” 

button to continue. 

 

 

After that, you will choose the network connection. Please input your proxy settings according your 

network environment if necessary. Then click “OK” button to continue. 
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In the next screen, select the install directory in which the SPM Simulator will be installed. Then 

click “OK” button to continue. 

 

The installer starts to install the SPM Simulator module in the requested directory. 

 

 

 

After the installation of SPM simulator module has been completed, the “Next” button will get 
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enabled. Click the “Next” button to continue. 

 
 

The registration screen to a server is shown. Wait just a moment. 

 
 

After the registration to a server is completed, the following screen is shown and the “Next” button 

will get enabled. Click the “Next” button to continue. 
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The screen of completion is shown. You can create desktop shortcuts of the SPM simulators and can 

register the SPM simulator to your start menu. Please check them if you need, and click the “Finish” 

button. Then installation has been all completed. 
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Chapter 2 

Operation of the software 
 

 

 

1  Overview of the GUI 

 

 

In this software, a XML file, which is called 'project file', manages in a unified manner all 

information required for simulating, such as component data (tip, sample, image), initial position of 

them, parameters used by each simulator and result file paths of calculation. Each simulator loads 

this project file as an input. The result files are written down at the indicated paths during and after 

the calculation. The integrated GUI helps you to create and edit a project file, and renders a 

calculation condition and the simulated results in a variety of forms (see figure below). 

 

 

Project file 

Create/Edit 

Diaplay 

      
Calculation result files 

  

Integrated GUI 

Reference 

Component data 

(Tips、Samples、Images) 

Simulators 

MD 

FEM 

DFTB 

CG 

GEO 

1  Overview of the GUI  
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2  Part names and functions 

 

 

 

 

Project Editor 

Main View 

Log View 

Result View 

Menu Bar & Tool Bar 

DB View 

Project View 

Data View 

2  Part names and functions 
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We explain the main functions of each part on the screen. 

 

【Menu Bar & Tool Bar】 

With this bar, you can do file operations such as creating, loading and saving a project file, 

simulation control operations such as selecting and running a simulator, replaying, pausing and 

stopping the simulation and switching display of each window on and off . 

 

【Project Editor】 

Contents of a project file are shown as a tree view on this window. You can edit the shown 

values directly. The changes are immediately reflected on “Main View”. 

 

【Main View】 

The Main View visualizes the setup information described in a project file such as components, 

initial positions of them and a scanning area. A layout of the components can be changed with 

use of a mouse, a keyboard and slider bars, and the changes are immediately reflected on 

"Project Editor". In addition, movement of a tip and deformation of samples are visualized 

during a simulation. 

 

【Result View】 

In this window, calculation results are rendered as images during and after a simulation. 

 

【Log View】 

Messages from a simulator or GUI are shown on this window. 

 

【DB View】 

A list of the components (molecular data of tips and samples) registered into database 

previously is shown on this window. In order to take a component you want into a project from 

the list, you only have to double-click the component.   

 

【Project View】 

Contents of a project file are shown by a text format on this window. You can not edit directly. 

 

【Data View】 

Numerical data of component is shown on this window. In the case of molecular data, charge 

information and movable/unmovable information of each atom can be set and be edited. But 

atomic species and coordinates of atoms can not be edited. 
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3  Start up GUI 

 

 

 

 

 

1. a. Double-click "SPM Simulators" icon on your desktop. 

1. b. Double-click (installed directory)¥SPMSimulator.exe. 

 

See chapter 6 “Trouble Shooting” if GUI does not start up normally. 

 

 

 

3  Start up GUI 
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4  Operations of a project file 

 

 

After starting up GUI, all operations begin from loading a project file. After a project file is loaded, 

the next step is to edit and save the file by use of GUI, and the final step is to run a simulation. In 

this section, we explain about file operations such as creating, loading and saving a project file. 

 

Create a new project  

 

 

1. “Menu Bar”  [File]  [New]1  “Create new project” dialog box 

2. Input “Project name”  input “Directory”  [OK] 

  

On "Create new project" dialog box, you have to specify "Project name" and "Directory" (in which 

files for a project is made). Using [Ref] button, you can easily select "Directory" by use of an 

additional dialog. 

 After [OK] button is pressed, a directory named as "Project name" is created in "Directory", and a 

project file is created there. 

 For example, if you input 'C:¥' as "Directory" and 'test' as "Project name", 

        C:¥test¥test.pro 

                                                             
1 This operation can also be made by clicking “New” icon on “Tool Bar”. 

Simulator Tab 

4  Operations of a project file 
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is created. 

 After a project file is created, a "Component" item is added on "Setup" tab in "Project Editor", and 

default parameter values are set automatically on "Simulator Tab" ("DFTB" in the figure). 

 

 

Load an existing project file  

 

【Load with the use of a file dialog box】 
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1. “Menu Bar”  [File]  [Open]2  “Open Project” dialog box 

2. Select a project file (*.pro)  [Open] 

 

When a selected project is loaded, setup information and simulator's parameter information are 

shown on each tab of "Project Editor". Simultaneously, components such as a tip and samples are 

visualized on “Main View”. 

 In addition, if calculation results already exist, they are rendered on "Result View". 

 

【Load a recently used project file】 

 

1. “Menu Bar”  [File]  [Recent Files]  a list of project files3
select a file 

 

【Reload】 

 

 

1. “Menu Bar”  [File]  [Reload]4 

                                                             
2 This operation also can be made by clicking “open” icon on “Tool Bar”. 
3 10 recent files are shown at the most. 
4 This operation also can be made by clicking “Reload” icon on “Tool Bar”. 
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When setup information and parameter values are changed before saving the project file, the 

project can be returned to the last saved state by reloading. 

 

 

Show a project file 

 
1. “Menu Bar”  [Display]  [Current Project File: file name] 

 

At the back of 'Current Project File:' the name of the current project file is shown. By selecting this 

menu, "Project View" is up and contents of the project file can be watched.  But you can not edit 

the file directly on "Project View". Editing can be done on not "Project View" but "Project Editor". 

 

 

Save a project file 

 

When a project is edited on GUI, the modification does not reflect on the project file immediately. 

The project file is updated only after saving. 

 Because each simulator calculates with reference to the project file, the project file needs to be 
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saved before calculation in order to reflect the modification of the project on a simulation result. 

 How to save a project file is as follows. 

 

【Save】 

1. “Manu Bar”  [File]  [Save]5  

 

 

【Save as】 

 

 

1. “Manu Bar”  [File]  [Save As]  “Save Project” dialog box 

2. Input “Project name”  input “Directory”  [OK] 

 

On "Save Project" dialog box, "Project name" and project "Directory" are set. 

 If [Ref] button is pressed, you can use dialog box to set "Directory". 

 By pressing [OK] button, a directory which is the same name as project (called project directory) is 

                                                             
5 This operation also can be made by clicking “Save” icon on "Tool Bar". 
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created in the directory which "Directory" indicate, and a project file is created in the directory and 

saved. 

 At that time, all files needed for the project including component data and result files are copied 

into the project directory. 

The current project file name is described on the title bar, on the top of GUI, and if the project is 

edited, symbol "*" appears behind this file name. 

 This symbol disappears after saving. 

 

 

Close a project 

 

 

 

1. “Manu Bar”  [File]  [Close]6  

 

When the project is closed, all contents are deleted from "Project Editor", and the “Main View” is 

also cleared.  

 

 

                                                             
6 This operation also can be made by clicking “Close” icon on "Tool Bar". 
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5  Edit project 

 

 

Components 

 

(1) Add, replace, remove 

There are three kinds of component such as tip, sample and image. We now explain about a tip as 

an example. 

 

【Add】 

 

 

5  Edit project 
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1. “Project Editor”  “Setup” tab 

2. Right-click on “Component” item  context menu7 

3.  a. [Add Tip]  [Database]  “DB View”  double-click a component 

    b. [Add Tip]  [File]  “Import File” dialog box  select a file  [Open] 

    c. [Add Tip]  [Sphere/Cone/Pyramid/Pillar]  parameter input dialog box  input radius 

and angle  [OK] 

 

 

In the case of a tip, data to be added can be selected from [Database], [File], and four kinds of 

shape model [Sphere], [Cone], [Pyramid] and [Pillar]. Each of them has its own dialog box8. 

 In the case of [Database], a tip can be added by selecting and double-clicking a tip name from the 

data list. In the case of [File], open file dialog box is used. In the case of shape models, input dialog 

boxes for angle and radius will rise in accordance with the shape type. 

 

When specified data are loaded by the operation described above, the item named "Tip" is added 

below "Component", and information of the tip is shown below “Tip” item. Simultaneously the tip 

is visualized on “Main View”. Samples and an image can be added9 in the same manner. 

 

【Add an image file】 

Graphics files, such as bitmap and jpeg, have information of brightness, but do not have 

information of height. Therefore it is necessary to convert brightness of an image into height data 

of a component10. It is also important to translate the image size into length and width of the 

component. We explain how to load an image file of a sample component as an illustration. 

                                                             
7 This menu also can be shown by selecting [Edit] on “Menu Bar” or by right-clicking on "Main View". 
8 A Sample is set only from [Database] or [File], and an image only from [File].  
9 Two or more samples can be added, while only one tip and only one image can be added. 
10 Unless brightness of the image file is proportional to height of the sample, you may not obtain a meaningful result. 
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1. “Project Editor”  “Setup” tab 

2. Right-click on “Component” item context menu11 

3. [Add Sample]  [File]  “Import File” dialog box  select an image file  [Open] 

4.”Set Image Width” dialog box  input “width”  [OK] 

5.”Set Image Height” dialog box  input “height”  [OK] 

6.”Set Value Range” dialog box  input “value range”  [OK] 

 

In "Set Image Width" and "Set Image Height" dialog boxes, you have to specify the width and length 

of the sample in angstrom unit, respectively. Next, "Set Value Range" dialog box specifies the 

vertical height in angstrom unit which corresponds to the brightness of the image from 0.0 (black) 

to 1.0 (white). 

 

                                                             
11 This menu also can pop up by selecting [Edit] on “Menu Bar” or right-clicking on "Main View". 
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【Replace】 

 

1. “Project Editor”  “Setup” tab 

2. Right-click on “Tip” item  context menu 

3. a. [Replace]  [Database]  “DB View”  double-click a component 

b. [Replace]  [File]  “Import File” dialog box  select a file  [Open] 

c. [Replace]  a shape model  an input parameter dialog box  input radius and angle value 

 [OK] 

 

Note that you right-click on “Tip” item (not “Component” in case of Addition) to replace with 

another tip. Of course “Sample” or “Image” can also be replaced in a similar way. Note also that the 

first item in a pop-up menu becomes [Replace], not [Add Tip]. 

 

【Remove】 

 

1. “Project Editor”  “Setup” tab 
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2. Right-click on “Tip” item  context menu 

3. [Remove] 

 

When the specified data are removed, the "Tip" item will be removed from under "Component". At 

the same time, the tip image also disappears on “Main View”. 

 

 

(2) Initial layout setting（position, rotation, reset） 

There are three kinds of component such as tip, sample and image. We here explain about a tip as 

an example. 

 

【Position】 

 

Let us move a tip along the z-direction. 

1. “Project Editor”  “Setup” tab 

2. a. “Tip”  “Position”12  double-click on “value” of “z”  spin box 

b. “Tip”  double-click on “value” of “DistanceFromSamples”13  spin box14 

3. Input a value15  Enter key 

                                                             
12 There are coordinates of the component in angstrom unit under “Position”. In case of a tip position, “value” of “x”, “y” and “z” 

stands for the coordinate at the bottommost atom. On the other hand, in cases of a sample or an image position, “value” of “x” 
and “y” stands for the center of the component ((xmin + xmax)/2 , (ymin + ymax)/2). And “value” of “z” stands for the bottom 
of the component (zmin).  

13 “value” of “DistanceFromSamples” in angstrom unit stands for (z-coordinate of the tip bottom) - (z-coordinate of the sample 

top). If a sample does not exist, this value is set to 0. 
14 This operation is valid only when moving along z-direction. 
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By the operation above, the tip is moved to specified coordinates on “Main View”. 

 

【Rotation】 

 

Let us rotate a tip around the x-direction16. 

1. “Project Editor”  “Setup” tab 

2. “Tip”  “Rotation”17  double-click on “value” of “alpha”  spin box 

3. Input a value18  Enter key 

 

By the above operation, the probe currently displayed on “Main View” rotates the specified angle 

in degree around x-direction. This is the same around y- and z-direction.  However, images can not 

be rotated.  

 

 

 

 

                                                                                                                                                                                   
15 We can move a component by the use of the slider bars on “Main View” or by dragging a component with “Shift” key down 

on ”Main View”. Note that in the case of moving and rotating a component with mouse operation on ”Main View”, the 
component need to be selected (see section 9) on the “Setup” tab of “Project Editor”. When there is no selected component, 
we can only change the view point, while the layout of the component is fixed. 

16 At the present time, we can rotate the components loaded from “*.pdb”, “*.xyz” and “*.txyz” data format. 
17 There are rotation angles around three axes below “Rotation” in degree. “value” of “alpha”, “beta” and “gamma” represent the 

rotation angles around x-, y- and z-direction, respectively. In case of a tip, the center of the rotation is set at the bottommost 
atom. While, in case of a sample, the center of the rotation is the same as the center of the sample. Rotations will be made in 

the order, “alpha”  “beta”  “gamma”. 
18 The range of rotation angle is between [-180, 180] degrees. You can also rotate a component by dragging a mouse on “Main 

View”. 
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【Reset】 

 

1. “Tool Bar”  [Reset Layout] 

 

By the operation above, position and rotation angle of each component are reset to the value 

which the project file contains at the time. Simultaneously the layouts of components on “Main 

View” are also reset. 

 

 

(3) Show data, modify attributes 

We explain how to show the numerical data of a component and to modify attributes.  

 

1. “Project Editor”  “Setup” tab 

2. Right-click on “Sample” item  context menu  [Show]  “Data View” 

3. Input19  the value of “Relax”20 and “Charge”  [OK] 

 

By the operation above, the attributes of each atom are replaced, and changed values are saved 

into a project file. When the value of “Relax” of an atom is 1, the atom may move by atomic forces 

during a simulation. As a result, a molecule may be deformed due to the changes of atom positions. 

 

Set and show a scanning area 

                                                             
19 For now, you can change the attributes only when using the data of “*.pdb”, “*.xyz” and “*.txyz”. Note that atomic species and 

coordinates of the atom are not editable.  
20 “Relax” = 0 means “cannot move” in the atom coordinates, and “Relax” = 1 means “can move”. 

Reset Layout 
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We introduce how to change a height of a scanning area. 

 

 

1. “Project Editor”  “Setup” tab 

2. “Tip”  “ScanArea”21  double-click on “value” of “h”  spin box 

3. Input a value Enter key 

4. Right-click on “Main View”  context menu  [Show Scan Area]22 

 

The operation above changes the height of the scanning area, and the range is shown as a blue 

rectangular box on "Main View". In the same manner, you can change the width and the depth of 

the scanning area with the use of “w” and “d” at “ScanArea”, respectively. 

 

 

Select a simulator and set parameters 

 

We explain below how to select the quantum SPM image simulator (DFTB). 

                                                             
21 There are width (w), depth (d) and height (h) (in angstrom unit) of the scanning range under the “ScanArea”. Starting from the 

bottom position of the tip, the tip scans w, d and h values along x-, y- and z-direction, respectively. 
22 [Show Scan Area] is a toggle button, so that it makes the scanning area shown and hidden alternately. 
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1. “Tool Bar”  “Simulator Combo Box”  [MD/CG/DFTB/FEM]23 

2. “Project Editor”  “Simulator Tab” 

3. Double-click “value” of each parameter  each input control24 

4. Input data Enter key 

 

Before setting parameters, you have to select a required simulator. Either among 

MD/CG/DFTB/FEM can be selected25 with use of "Simulator Combo Box". According to the selected 

simulator, the title of "Simulator Tab" is changed automatically (it is DFTB on the figure). Next, each 

parameter value needs to be input on "Simulator Tab". About the meaning of each parameter, refer 

to another attached document "Reference Manual". When a new project is created, each 

parameter contains default values. 

 

Regardless of the selection of a simulator, there is an “Output” item on “Simulator Tab”, and a 

"Directory" item just under that. File names of the calculation results are indicated under 

"Directory". The results are outputted to them when each simulator is executed. Keep in mind that 

if same named files already exist, these files are overwritten26 . 

                                                             
23 A simulator can also be selected by “Menu Bar”  [Simulation]  [Solver]. 
24 The input control changes automatically such as a spin box in the case of a numerical value and a text box in the case of a letter 

according to the requested data format. 
25 GEO simulator has its own usage. Read chapter 3 section 1 'high-speed mutual prediction - AFM simulator'. 

26 The old files are renamed into “filename~” for backup automatically. 

 

Simulator Combo Box 

Simulator Tab 
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6  Simulation 

 

 

Calculate, replay, stop, and pause 

 

【Calculation / replay】 

 

Calculation/Replay Combo Box Start 

6  Simulation 
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1. “Tool Bar”  “Calculation/Replay Combo Box”  [Calculation/Replay] 

2. “Tool Bar”  [Start] 

 

At first, you choose [Calculate]27 or [Replay] "Calculation/Replay Combo Box". [Replay] requires the 

existing calculation results. Next, the [Start] button will start the calculation or replay. During the 

simulation, the "Main View" shows a movement of the tip and a deformation of the samples in 

sequence. In addition, the calculation results are rendered on "Result View". The messages from 

the simulator are shown on "Log View". 

 

【Stop, pause】 

 

1. “Tool Bar”  [Stop] or [Pause] 

 

After a simulation starts, [Start] button becomes unavailable, while [Stop] button becomes available. 

If [Stop] button is pressed, the simulation stops. 

 [Pause] button is available only in the case of replaying. This button suspends the replay. Press the 

[Start] button again to resume replaying. During the simulation, you see a progress of the 

simulation on "Progress Bar". 

 

 

Render the result 

 

【Select data for rendering】 

                                                             
27 The simulator which is selected on “Simulator Combo Box” is run. 

Progress Bar Stop Pause 
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1. “Result View”  [Result Data Combo Box]  select a result outputted file 

 

There is a list of the result files in "Result Data Combo Box"28, which is described under ”Project 

Editor”  “Simulator Tab”  ”Output”  “Directory”. When a file is selected from the list, "Result 

View" draws a graph, a gradation figure and so on according to the data format. 

 

【Show values】 

 

1. Right-click on “Result View”  context menu  [Show Data]  

 

【Save As】 

                                                             
28 The list changes according to the simulator selected on “Simulator Combo Box”. 

Result Data Combo Box 
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1. Right-click on “Result View”  context menu  [Save As…]  “Save As” dialog 

2. Input a new name  [Save] 

 

By this operation, the result data can be saved as a different data format or as a different name.  

 

【3D-View of a gradation figure】 

 

 

1. Right-click on “Result View”  context menu  [3D-View] 
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【Change of a viewpoint】 

 

1. Right-click on “Result View”  context menu  [Top/Front/Side] 

 

By this operation, you can get the specific viewpoints such as top view (Top), front view (Front) and 

side view (Side). In addition, the viewing angle can be changed freely by dragging on "Result View", 

and the viewpoint can be translated by dragging with “Shift” key down. 

 

【Zoom All】 

 

1. Right-click on “Result View”  context menu  [Zoom All]29 

                                                             
29 [Zoom All] button on "Tool Bar" works as the same function. 
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By this operation, resizing and translation are automatically made for the purpose of storing drawn 

picture in the whole screen of "Result View". 

 

【Scaling】 

1. a mouse wheel  rotate 

Scaling can be carried out to arbitrary magnification by rotating the mouse wheel. 

 

【Perspective】 

 

1. Right-click on “Result View”  context menu  [Perspective] 

[Perspective] is a toggle button, so that it makes the view perspective or not alternately. 
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【Cross section of a gradation figure】 

 

 

1. Double-click on “Result View”  mark a starting point 

2. Double-click on “Result View”  mark a terminal point 

3. Right-click on “Result View”  context menu  [3D-View] 

4. Right-click on “Result View”  context menu  [Cross-Section]  [Clipping] 
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7  Visualization setting 

 

 

Show/hide a component 

 

Here we show how to show or hide a component, e.g. a tip. 

 
1. Right-click on “Main View”  context menu  [Show Tip]30 

 

Showing/hiding of the samples or the image can be toggled in the same manner. 

 

 

Change viewpoint, zoom all, scaling, and perspective 

 

【change of a viewpoint】 

                                                             
30 [Show Tip], [Show Sample] and [Show Image] are toggle buttons, which make each of them visible or not alternately. 

7  Visualization setting 
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1. Right-click on “Main View”  context menu  [Top/Front/Side] 

 

By this operation, you can get the specific viewpoints such as top view (Top), front view (Front) and 

side view (Side). In addition, when no component is active, the viewing angle can be rotated freely 

by dragging on "Main View", and the viewpoint can be translated by dragging with “Shift” key down. 

Three slider bars on "Main View" also translate the viewpoint. 

 

Front Top Side 
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【Zoom All】 

 

1. Right-click on “Main View”  context menu  [Zoom All]31 

By this operation, scaling and translation are automatically made for the purpose of storing 

components in the whole screen of "Main View". 

                                                             
31 This operation also can be made by clicking “Zoom All” on “Tool Bar”. 
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【Scaling】 

1. mouse wheel  rotate 

Scaling can be carried out to arbitrary magnification by rotating the mouse wheel. 

 

【Perspective】 

 

 

1.  Right-click on “Main View”  context menu  [Perspective] 

[Perspective] is a toggle button, so that it makes the view perspective or not alternately. 
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View option setting 

 

【Switch molecule rendering methods】32 

 

1. Right-click on “Main View”  context menu 

2. [View Option]  [Auto/Dot/Ball/Ball & Stick/Cartoon] 

 

[View Option] changes the method of drawing molecules. When [Auto] is selected, an appropriate 

method is automatically chosen depending on a component data. Note that some methods do not 

work according to file formats. [Ball & Stick] needs information of atomic bonds, and [Cartoon] 

corresponds only to PDB file. 

 

【Toggle translucent/opaque】 

                                                             
32 Currently this operation can be made about the component data only with “*.pdb”, “*.xyz” or “*.txyz” extension.  

Dot Cartoon Ball Ball & Stick 
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1. Right-click on the “Main View”  context menu 

2. [View Option]  [transparent]33, 34 

 

                                                             
33 [transparent] is a toggle button, so that it makes the picture translucent or opacus alternately. 
34 This operation can be made only for the grid formed files which have extensions of “*.cube”, “*.csv”, “*.bmp” or “*.jpg”. 
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【Toggle with/without wire】 

 

 

1. Right-click on “Main View”  context menu 

2. [View Option]  [with wire]35 36 

                                                             
35 [with wire] is a toggle button, which changes the image 'with wire' or 'without wire' alternately. 
36 This operation can be made only for “*.cube”, “*.csv”, “*.bmp” or “*.jpg” formed files. 
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8  Quit GUI 

 

 

 

 
 

1. “Menu Bar”  [File]  [Quit] 

 

 

8  Quit GUI 
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9  Others 

 

 

Show/hide window 

 

 

 

1. “Menu Bar”  [Display]  [Project Editor/ Result View/ Log View]37 

The operation above makes each of three windows, "Project Editor", "Result View" and "Log View", 

                                                             
37 [Project Editor], [Result View] and [Log View] are toggle buttons, which makes each of them visible or not alternately. 

9  Others 
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visible or not alternately38. In addition, double click the title bar of each window, so that each 

window can be separated from or docked to the GUI. However, “Main View” can not be hidden or 

separated from the GUI. 

 

 

Select a component  

 

【Select】 

 

 

1a. “Tool Bar”  “Component Combo”  select a component name39 

1b. “Project Editor”  click a content of components 

1c. “Main View”  double-click around a component40 

 

You can select a component by any method of 1a, 1b and 1c. If a component is selected, the outer 

frame of the component changes from green to red on "Main View". The selected component can 

be translated and rotated by operations of mouse, slider bars and keyboard. When no component is 

selected, the viewpoint is changed by the same operation. 

 

                                                             
38 A window can be hidden by pressing “×” button on the top of each window too. 
39 A list of components contained on “Project Editor” is shown here. 
40 By this method component data only with “*.pdb”, “*.xyz” or “*.txyz” extension can be selected. 

Component Combo Box 
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【Deselect】 

 

 

1a. “Tool Bar”  “Component Combo”  [No Selected] 

1b. “Project Editor”  click “Component” 

1c. “Main View”  double-click background 

 

The component can be deselected by any method of 1a, 1b and 1c. 

 

 

Registration of components to the database 

 

You can register your own component data to the database as follows. Copy your tip data into  

 “(installed directory)¥data¥Tip¥”, 

and your sample data into 

 “(installed directory)¥data¥Sample¥”. 

The registered data of tips and samples are now available from "DB View" for tips and samples, 

respectively. Note that the component data only with "*.pdb", "*.xyz" or "*.txyz" extension can be 

registered. If there is an image file whose name is "(data file name).gif" at the same directory, the 

image is shown as icon on “DB View”. 
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Export image 

 

【Export screen shot of “Main View”】 

 

1. “Manu Bar”  [File]  [Export Image]  “Save Capture” dialog box 

2. Input an image file name  [Save] 

 

【Export screen shot of “Result View”】 

 
 

1. Right-click on “Result View”  context menu 

2. [Export Image]  “Save Capture” dialog box 

3. Input an image file name  [Save] 
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Chapter 3 

Case study 
 

 

Here, we introduce some case studies calculated by SPM Simulator. Using the project files for these 

studies included in the package of the software, calculation procedure of representative case 

studies of simulations are described.  

 

 

1  Geometrical and tip-sample-image interactive AFM simulator 

 

 

Introduction 

 

Geometrical Mutual AFM Simulator (GeoAFM) provides users with a kind of a three-way data 

processor, so that it reconstructs the one out of the other two among three geometrical elements, 

a tip, sample material and its AFM image. Because this module accomplishes numerical calculations 

for the simulation very rapidly, users can obtain results in a few seconds. 

 

A characteristic of this module is that it can only sort out geometrical data of the tip, the sample 

material and its AFM image. Thus, it never includes the contribution caused by the van der Waals 

interaction between the tip and the sample material. Moreover, this simulator assumes that the tip 

and sample material never suffers from deformation. Hence, the GeoAFM produces a result from 

only the information of the geometry of the tip, the sample material and the AFM image. 

Throughout the simulation, this module assumes that the tip always touches the surface of the 

sample material, so that it scans the surface of the sample in the so-called contact mode. 

 

As mentioned above, the GeoAFM never takes equations of both classical and quantum physics into 

account. Considering the tip, the sample material and its AFM image to be genuine geometrical 

objects and assuming the tip and the sample material always to be in the contact mode, this 

module performs the simulation in a manner of elementary geometry. Thus, this simulator is not 

suitable for investigating phenomena of the microscopic system, where the quantum effects are 

significant. In contrast, this module is very suitable for simulating AFM images of semiconductor 

1  Geometrical Mutual AFM Simulator 
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devices with dimensions on the nanoscale and biological macromolecules. Hence, in general, the 

users have to apply the GeoAFM to simulating AFM images at mesoscopic scale. 

 

From now on, we look around how to use the GeoAFM with some concrete examples. As 

mentioned above, the GeoAFM works as a kind of the three-way data processor, so that we can use 

it in the following three manners: 

 Simulation of the AFM image, from the geometrical data of the tip and the sample 

 Simulation of the sample surface, from the geometrical tip data and the observed AFM image 

 Simulation of the tip surface, from the geometrical sample data and the observed AFM image 

 

Let us try these three simulations one by one in the following subsections. 

 

 

Simulation of the AFM image, from the data of the tip and the sample 

 

In this subsection, using the GeoAFM, we derive the AFM image of a single molecule of 

Glycoprotein (1clg) on HOPG（Highly Oriented Pyrolytic Graphite）. In the simulation, we make use 

of a quadrilateral pyramid probe tip. 

 

First, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. In the dialog box, [Project name] is blank. Then, type a string 

“test-geoafm001” for [Project name], and a new project file, whose name is given by 

“test-geoafm001.pro”, will be generated automatically. 

 

At the second item of [Directory] in the dialog box of [Create new project], the full absolute path of 

the directory, where the executable file of the SPM Simulators exists, is shown. This implies that a 

new folder “test-geoafm001” for the current project will be created at this directory. Executing the 

simulation, the project file and other various data files will be saved in this folder. In this case, this 

configuration is convenient because we can let related files be together in this folder. Then, click the 

[OK] button. 

 

Next, we load the geometrical data of both the tip and the sample material as follows. Click the tab 

[Setup] in the [Project Editor], and you will find the item [Component] at the top of the page. 

Right-click on the item [Component] and select [Add Tip] > [Pyramid]. Then, a dialog box of [angle 

(deg)] appears to define the angle at the top of pyramid. The parameter, 32.0 degrees, is given as 

the default value for the angle, so that we click the [OK] button. Right-click on the item 
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[Component] again and choose the item [Add Sample] > [Database]. Then, a database appears for 

typical materials prepared previously. Here, we choose [1clg-HOPG] put on the top of the database. 

 

At present time, the window shows the following images. A light blue square located in the center 

of the window represents the tip in the shape of the pyramid with viewing from the bottom. The 

window displays a chain of the molecule and a substrate made out of graphite, as well. 

 

 

 

To store up our work done already, we save the project file here. Click the item [File] > [Save], and 

you can save a new version of the existing project file as “test-geoafm001.pro”. While you are 

working with the project file in the GeoAFM, you have to save it frequently to avoid losing data 

unexpectedly. 

 

Now, we execute numerical calculations with the GeoAFM. Put the cursor on the window, which 

displays the tip and the sample, and right-click on it. Then, the following context menu appears.  
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Let us define a resolution of the AFM image, which we are going to obtain with the numerical 

simulation. Select the item [GeoAFM] located at the bottom of the context menu, and click [Set 

GeoAFM Resolution]. Then, you can type the value of the resolution. The resolution represents the 

minimum length of the numerical calculations for obtaining the AFM image. A unit of the resolution 

is given by angstrom and you can adjust its value by 0.1. The maximum value of the resolution is 

given by 10.0. A default value of the resolution is put at 5.0 [angstrom] previously. 

 

Here, let us put the resolution at 1.0 [angstrom]. In the actual process of simulation, you have to 

adapt it with referring the resolution of the observed AFM image in the real experiments. You need 

to pay attention to the following fact. If you take a much smaller value for the resolution compared 

with the typical length of the sample material, the amount of the numerical calculations becomes 

larger extremely and the simulator freezes. Thus, you have to be careful for tuning the value of the 

resolution. 

 

Next, choose the item [GeoAFM] at the bottom of the context menu again, and click [Show 

Simulated Image]. Then, you obtain orange contours in the window. They represent the AFM image 

derived by the numerical calculation of the GeoAFM.  
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We can modify a scanning area of the AFM image. When we set the tip position (x, y) at 

[Tip]>[Position] and set the width and the depth of the scanning area (w, d) at [Tip]>[ScanArea], 

then the AFM image is displayed in the specified rectangular region. On the other hand, even one 

of w or d at [Tip]>[ScanArea] is zero, then the scanning area is automatically determined to cover 

the sample area. Here we choose the scanning area automatically. 

 

To let the AFM image obtained numerically be distinct, we remove original images of the tip and 

the sample form the window. Putting the cursor on the main window and right-clicking on it, you 

will open a context menu. Then, remove ticks from items [Show Tip] and [Show Sample] by clicking 

them, and you can let the window display only the AFM image. 

 

As mentioned above, we reach at the window displaying only the AFM image, which is a result of 

numerical simulation. Drag the cursor on the main window, and you can rotate the AFM image in a 

3D manner freely. Click an icon of a magnifying glass on the toolbar, and you can enlarge the AFM 

image to let it fit into the main window. For example, you can let the main window afford the fine 

view of the AFM image of the long chain of the molecule at ease, as shown below. 
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Now, we store up the AFM image obtained by the numerical calculations as a data file, which is 

reusable for other purposes later. Putting the cursor on the main window and right-clicking on it, 

you have a context menu. Then, choose the item [GeoAFM] > [Export Simulated Data] in the 

context menu, and type the data file name as “test-geoafm001-image”. As a result of these 

operations, you can save the AFM image obtained with the numerical calculations as 

“test-geoafm001-image.cube”. The extension “cube” stands for a data file saved into the SPM 

simulators’ own file format. 

 

After accomplishing the above procedures, choose the items [File] > [Save] and [Close], and you can 

finish the project. 

 

 

Simulation of the sample surface, from the tip data and the observed 

AFM image 

 

In this subsection, using the GeoAFM, we derive the geometry of the surface of the sample material 

from the geometrical data of the tip and the observed AFM image. In the simulation, we make use 

of a quadrilateral pyramid probe tip. Moreover, we use the data file of “test-geoafm001-image.cube” 

derived in the previous subsection as the AFM image of the single molecule of Glycoprotein (1clg) 

on HOPG (Highly Oriented Pyrolytic Graphite). 
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First, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. In the dialog box, [Project name] is blank. Then, type a string 

“test-geoafm002” for [Project name], and a new project file, whose name is given by 

“test-geoafm002.pro”, will be generated automatically. 

 

Second, we load the geometrical data of the tip. Click the tab [Setup] in the [Project Editor]. As 

explained in the previous subsection, we choose the pyramid probe tip. We use the default value of 

[angle (deg)], 32.0 degrees, for the angle of the top of the pyramid. 

 

Third, we load the data of the AFM image. As explained in the previous subsection, right-click on 

the item [Component] and choose the item [Add Image] > [File]. Here, we select the file 

“test-geoafm001-image.cube” stored up in the directory “test-geoafm001”, which we create in the 

previous subsection. 

 

At present time, clicking an icon of a magnifying glass on the toolbar and enlarging images to let 

them fit into the frame, we obtain the following window displaying both an image of the tip and the 

AFM image. 

 

 

 

As mentioned in the previous subsection, we put the resolution for simulation of the GeoAFM at 

1.0 [angstrom], and click the item [GeoAFM] > [Show Simulated Image]. Then, green contours 

appear in the main window. These contours represent the geometrical data of the surface of the 
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sample material. 

In the following figure, because both the green contours and the orange contours are shown 

together, they seem to be a yellow image. On the one hand, the green contours obtained by 

numerical calculations represent the surface of the sample material. On the other hand, the orange 

contours represent the AFM image given as the initial data for the simulation. 

 

 

 

To clarify the surface image obtained here, we hide the tip and the AFM image from the view. 

Right-clicking on the main window to open a context menu, you remove ticks of [Show Tip] and 

[Show Image]. Thus, only the image of the surface of the sample material is left in the main window. 

As shown in the following figure, to obtain a fine view of the chain of the molecule, you can rotate 

and zoom in on the image derived with the GeoAFM at ease. 
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Now, we store up the image of the surface of the sample material, obtained by the numerical 

calculations, as a data file being reusable for other purposes later. Putting the cursor on the main 

window and right-clicking on it, you open a context menu. Then, choose the item [GeoAFM] > 

[Export Simulated Data] in the context menu, and type the data file name as 

“test-geoafm002-sample”. As a result of these operations, you can save the image of the surface of 

the sample material as “test-geoafm002-sample.cube”, which is a data file with the “cube” format. 

 

 

Simulation of the tip surface, from the sample data and the observed 

AFM image 

 

In this subsection, using the GeoAFM, we derive the surface geometry of the tip from the 

geometrical data of the surface of the sample material and the observed AFM image. In the 

simulation, we use the data file of “test-geoafm001-image.cube” derived in the previous subsection 

as the AFM image of the single molecule of Glycoprotein (1clg) on HOPG (Highly Oriented Pyrolytic 

Graphite). 

 

At first, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. Then, type a string “test-geoafm003” for [Project name], and a new 

project file, whose name is given by “test-geoafm003.pro”, will be generated automatically. 
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Second, we load the geometrical data of the sample material. Right-click on the item [Component] 

in the tab [Setup], and choose the item [Add Sample] > [Database]. Then, a database for typical 

materials prepared previously appears. Here, we choose [1clg-HOPG] put on the top of the 

database. 

 

Third, we load the data of the AFM image. Right-click on the item [Component] and choose [Add 

Image] > [File]. Here, we select the file “test-geoafm001-image.cube”, which has been created 

already in the previous subsection and put into the directory “test-geoafm001”. 

 

At the present time, the window displays the following image. 

 

 

 

Here, as mentioned in the previous subsection, we put the resolution for the simulation of the 

GeoAFM at 1.0 [angstrom]. Then, click the item [GeoAFM] > [Show Simulated Image].  

 

To clarify the tip image obtained here, we hide the sample and the AFM image from the view. 

Right-clicking on the main window to open a context menu, you remove ticks of [Show Surface] and 

[Show Image]. After these operations, we obtain the following window, where only the tip is 

displayed as a geometrical object. 
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Now, we store up the image of the tip, obtained by the numerical calculations, as a data file being 

reusable for other purposes later. Putting the cursor on the main window and right-clicking on it, 

you open a context menu. Then, choose the item [GeoAFM] > [Export Simulated Data] in the 

context menu, and type the data file name as “test-geoafm003-tip”. As a result of these operations, 

you can save the image of the tip as “test-geoafm003-tip.cube”, which is a data file with the “cube” 

format. 
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2  Finite Element Method AFM simulator 

 

 

Introduction 

 

Finite Element Method AFM simulator (FemAFM) carries out numerical calculations for obtaining 

an AFM image according to the classical theory of elasticity. The van der Waals interaction between 

a tip and a sample material is taken into account in case of the non-contact mode. On the other 

hand, the adhesion forces due to the JKR (Johnson, Kendall, Roberts) theory are considered in case 

of the contact mode. Assuming that the tip and the sample material obey the differential equation 

of elasticity, the FemAFM solves it with the finite element method. Thus, the tip and the sample 

material are divided into many small parts with mesh generation, and the solver takes deformation 

of finite elements into account.  

 

 

 

The FemAFM treats three calculation modes as below. 

 [Non-contact mode]: A probe tip attached to the front edge of the cantilever scans the surface 

of the sample material, keeping the distance around a few angstroms.  

 [frequency shift image mode]: A cantilever, which is oscillated by an external force with a 

constant frequency, approaches a sample surface but does not contact with it. A frequency 

shift caused by an interaction between a tip and a sample is calculated. 

 [viscoelastic dynamics mode]: A cantilever is oscillated by an external force with a constant 

frequency at a single point on the sample surface. A sequential motion of the tip is calculated; 

the tip contacts to a sample, pushes a sample, and detaches from a sample. 

The FemAFM treats the classical mechanics with the van der Waals interaction between neutral 

molecules and atoms, so that it just only regenerates phenomena of classical physics. In contrast, 

this simulator cannot regenerates quantum effects at all. Thus, on the one hand, this simulator is 

not suitable for studying the microscopic system, where the AFM observes atoms and molecules 

one by one in a direct manner and the quantum effects are significant. On the other hand, this 

module is very suitable for simulating AFM images of semiconductor devices with dimensions on 

the nanoscale and biological macromolecules. Hence, in general, the users have to apply the 

FemAFM to simulations of AFM images at mesoscopic scale. 

 

As mentioned above, this simulator cannot treat quantum effects. If you want simulate the 

problems related to the Scanning Tunneling Microscope (STM) and other various Scanning Probe 

2  Finite Element Method AFM simulator 
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Microscopes (SPMs) which observe material as an atomic-scale image, you should not use this 

simulator, the FemAFM. To tackle these problems, which belong to realm of quantum physics, we 

recommend to you the Classical Force Field AFM Simulator (CG) and the Quantum Mechanical SPM 

Simulator (DFTB) bundled with the SPM Simulators. 

 

In addition to the above, we have to pay attention to the following fact. Using the FemAFM 

simulator, the AFM is supposed to scan samples in a vacuum environment or the air at room 

temperature. If you want to simulate the AFM experiments in a liquid environment, you have to use 

the Soft-Material Liquid-AFM Simulator (LIQ) bundled with the SPM Simulators. 

 

 

Simulation of an AFM image of an organic macromolecule (non-contact 

mode) 

 

In this subsection, we learn how to use the Finite Element Method AFM simulator (FemAFM) with a 

concrete example using [non-contact mode]. 

 

From now on, using the FemAFM, we derive the AFM image of a single molecule of Glycoprotein 

(1clg) on HOPG（Highly Oriented Pyrolytic Graphite） . In the simulation, we assume that a 

quadrilateral pyramid probe tip scans the surface of the sample. Moreover, we assume the distance 

between the tip and the sample to be equal to around a few angstroms, so that the AFM detects 

the van der Waals force with the so-called non-contact mode. 

 

First, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. In the dialog box, [Project name] is blank. Then, type a string 

“test-femafm001” for [Project name], and a new project file, whose name is given by 

“test-geoafm001.pro”, will be generated automatically. 

 

Second, we load the geometrical data of both the tip and the sample material from the item 

[Component]. Click the tab [Setup] in the [Project Editor], and you will find the item [Component] at 

the top of the page. Right-click on the item [Component] and select [Add Tip] > [Pyramid]. Then, a 

dialog box of [angle (deg)] appears to define the angle at the top of pyramid. The parameter, 32.0 

degrees, is given as the default value for the angle, so that we click the [OK] button. Right-click on 

the item [Component] again and choose the item [Add Sample] > [Database]. Then, a database for 

typical materials prepared previously appears. Here, we choose [1clg-HOPG] put on the top of the 

database. 
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Third, we define a resolution for the finite element method, which will be carried out by the 

FemAFM. Click the tab [FEM] in the [Project Editor], and you will find the item [simulation] > 

[resolution]. Then, you can type the value of the resolution. Here, let us put the resolution at 2.0 

[angstrom]. 

 

The resolution represents the minimum length of the numerical calculations for obtaining the AFM 

image. To be precise, the resolution represents a typical length between neighboring vertices of a 

mesh, which is prepared for numerical calculations of the finite element method. A unit of the 

resolution is given by angstrom and you can adjust its value by 0.1. The maximum value of the 

resolution is given by 10.0, and its default value is put at 2.0 [angstrom]. In the actual process of 

simulation, you have to adapt it with referring the resolution of the observed AFM image in the real 

experiments. 

 

At present time, the window displays the following image. 

 

 

 

Now, we define an area where the tip scans. Click the tab [Setup], and you will find the item 

[Sample] > [Size], which tells us that the width, the depth and the height of the sample material are 

given by 66.861 [angstrom], 156.464 [angstrom] and 23.152 [angstrom], respectively. 

 

Thus, we put the width and the depth of the scanning area at w=”68.0” [angstrom] and d=”160.0” 
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[angstrom], respectively. Then, the scanning area includes the sample material completely. 

Moreover, we pay attention to the fact that the resolution (2.0 [angstrom]) can be divided into the 

width and the depth of the area (68.0 [angstrom] and 160.0 [angstrom]) exactly, with nothing left 

over. Thus, we can split the scanning area into squares of the mesh exactly. 

  

In this case, the scanning area consists of 2720 squares, which is given by 34 (the width) multiplied 

by 80 (the depth). In general, if the number of squares that form the mesh of the scanning area 

becomes larger than 22500, given by 150 (the width) multiplied by 150 (the depth), the amount of 

numerical calculations for the FemAFM exceeds the capability of a personal computer and the 

simulation time increases extremely. Thus, you need to be careful for adjusting the resolution. 

 

The origin of the three-dimensional Cartesian coordinate system is put on the center of a substrate 

where the sample material lies. Thus, under the item [Tip] in the tab [Setup], enter the starting 

point for scanning as [Position] x=”-36.0”, y=”-80.0”, z=”30.0” and specify the scanning area as 

[ScanArea] w=”72.0”, d=”160.0”, h=”0.0”. 

 

Here, we pay attention to the following fact. To let the numerical calculations of the finite element 

method be stable and proper, you need to set the value “z” in the item [Tip] > [Position] 

considerably larger than the value “h” in the item [Sample] > [Size]. If the distance between the tip 

and the surface of the sample material is not large enough, the van der Waals interaction between 

the tip and the sample material becomes too strong. This causes unstable numerical calculations. 

Because the FemAFM regenerates the van der Waals force from the Lennard-Jones potential 

throughout its numerical calculations, the interaction between the tip and the sample material is in 

proportion to the inverse of the distance to the sixth power. Thus, the strength of the interaction 

becomes extremely larger all of a sudden, when the tip approaches the surface of the sample 

material gradually. This sudden increase in the strength of the interaction sometimes makes the 

numerical calculations unstable. 

 

After the above operations, right-click on the main window to open a context menu. Then, make a 

tick at the item [Show Scan Area] in the context menu, and you will obtain the following images in 

the main window. A purple rectangle shown in the main window represents the scanning area. 
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Then you should input the physical properties of the tip or the sample, such as Poisson’s ratios, 

Young’s moduli and the Hamaker constants, those are placed at [Setup] tab > [Tip] > [Property] or 

[Sample] > [Property]. The default values are 76.5 [GPa] for [young], 0.22 for [poission], 50 [zJ] for 

[hamaker], which you can change as you like. We here use the default ones. 

 

The last step before starting your simulation is as follows. You assign the number of threads for the 

parallel computing in [OpenMP_threads] in [FEM] tab, where the default value 1 means the single 

thread computing. If you set 4 for [OpenMP_threads], your simulation will be done by four cores. 

There are three choices in [simulation_mode] in [FEM] tab, where we now use 

“femafm_Van_der_Waals_force” (default value).  

 

After the above preparations, choose [FEM] at the “Simulator Combo Box”, and select [Calculation] 

at “Calculation/Replay Combo Box” on the toolbar. Then click an arrow icon on the toolbar to start 

the simulation. You can display an AFM image obtained as results of the numerical calculations by 

choosing the item [Display] > [Results] in the menu bar. 
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Right-click the result window to open a context menu. Then choose [3D-View] to get to see the 

following 3D image. 

 

 

 

When you look at the above AFM image obtained by the FemAFM, you have to pay attention to the 

following fact. In the AFM image, the numerical value given at every point on the surface of the 

sample material represents strength of force acting on the tip, not a height of the sample surface. 

During the simulation, the tip moves on the scanning area (the xy plane), keeping the tip-to-sample 

distance unchanged. The unit of the force acting on the tip is given by [N] (Newton). 

 

Simulation of an AFM frequency shift image of a crystalline silicon 
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surface (frequency shift image mode) 

 

In this subsection, we learn how to use [frequency shift image mode] of the FemAFM simulator. A 

cantilever, which is oscillated by an external force with a constant frequency, approaches a sample 

surface but does not contact with it. A frequency shift caused by an interaction between a tip and a 

sample is calculated. 

 

We here simulate an AFM frequency shift image of a crystalline silicon (001) surface using a 

quadrilateral pyramid probe tip. We assume that the tip oscillates above the surface and never 

contact with it. 

 

First, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. In the dialog box, [Project name] is blank. Then, type a string 

“test-femafm200” for [Project name], and a new project file, whose name is given by 

“test-geoafm200.pro”, will be generated automatically. 

 

Second, we load the geometrical data of both the tip and the sample material from the item 

[Component]. Click the tab [Setup] in the [Project Editor], and you will find the item [Component] at 

the top of the page. Right-click on the item [Component] and select [Add Tip] > [Pyramid]. Then, a 

dialog box of [angle (deg)] appears to define the angle at the top of pyramid. The parameter, 32.0 

degrees, is given as the default value for the angle, so that we click the [OK] button. Right-click on 

the item [Component] again and choose the item [Add Sample] > [Database]. Then, a database for 

typical materials prepared previously appears. Here, we choose [si001]. 

 

Third, we define a resolution for the finite element method, which will be carried out by the 

FemAFM. Click the tab [FEM] in the [Project Editor], and you will find the item [simulation] > 

[resolution]. Then, you can type the value of the resolution. Here, let us put the resolution at 2.0 

[angstrom]. 

 

At present time, the window displays the following image. 
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Now, we define an area where the tip scans. Click the tab [Setup], and you will find the item 

[Sample] > [Size], which tells us that the width, the depth and the height of the sample material are 

given by 14.28665 [angstrom], 13.52978 [angstrom] and 8.16468 [angstrom], respectively. 

 

Thus, we put the width and the depth of the scanning area at w=”16.0” [angstrom] and d=”16.0” 

[angstrom], respectively. Then, the scanning area includes the sample material completely. 

Moreover, we pay attention to the fact that the resolution (2.0 [angstrom]) can be divided into the 

width and the depth of the area (16.0 [angstrom] and 16.0 [angstrom]) exactly, with nothing left 

over. Thus, we can split the scanning area into squares of the mesh exactly. 

 

The origin of the three-dimensional Cartesian coordinate system is put on the center of a substrate 

where the sample material lies. Thus, under the item [Tip] in the tab [Setup], enter the starting 

point for scanning as [Position] x=”-8”, y=”-8”, z=”26” and specify the scanning area as [ScanArea] 

w=”16”, d=”16”, h=”0”. 

 

After the above operations, right-click on the main window to open a context menu. Then, make a 

tick at the item [Show Scan Area] in the context menu, and you will obtain the following images in 

the main window. A purple rectangle shown in the main window represents the scanning area. 
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Then you should input the physical properties of the tip or the sample, such as Poisson’s ratios, 

Young’s moduli and the Hamaker constants, those are placed at [Setup] tab > [Tip] > [Property] or 

[Sample] > [Property]. The default values are 76.5 [GPa] for [young], 0.22 for [poission], 50 [zJ] for 

[hamaker], which you can change as you like. We here use the default ones. 

 

The other required physical properties are adjustable in [FEM] tab. Input a density of the tip and a 

spring constant of the cantilever in [density] and [spring_constant], respectively, under [Tip] > 

[Property]. The default values are 2329.0 [kg/m3] and 0.05 [N/m], respectively. Input also the 

surface tension in [surface_tension] under [Sample] > [Property], where the default value is 0.108 

[N/m]. We here use the default ones. 

 

We specify the external oscillation of the cantilever in [amplitude] and [frequency] under 

[simulation] in [FEM] tab. Input 150 [angstrom] and 0.5 [GHz], respectively. 

 

The last step before starting your simulation is as follows. You assign the number of threads for the 

parallel computing in [OpenMP_threads] in [FEM] tab, where the default value 1 means the single 

thread computing. If you set 4 for [OpenMP_threads], your simulation will be done by four cores. 

There are three choices in [simulation_mode] in [FEM] tab, where we now use 

“femafm_frequency_shift”.  
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After the above preparations, choose [FEM] at the “Simulator Combo Box”, and select [Calculation] 

at “Calculation/Replay Combo Box” on the toolbar. Then click an arrow icon on the toolbar to start 

the simulation. You can display an AFM frequency shift image obtained as results of the numerical 

calculations by choosing the item [Display] > [Results] in the menu bar. In this 2D image, the height 

dimension is [Hz]. 

 

 

 

Right-click on the result window to open a context menu. Then choose [3D-View] to get to see the 

following 3D image. 
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Simulation of an AFM viscoelastic dynamics analysis of a crystalline 

silicon surface (viscoelastic dynamics mode) 

 

In this subsection, we learn how to use [viscoelastic dynamics mode] of the FemAFM simulator. A 

cantilever, which is oscillated by an external force with a constant frequency, approaches a specified 

point on a sample surface. The simulator calculates the tip motion; the tip contacts with the surface, 

is pushed into the surface, and is about to be detached from the surface. 

 

We here simulate a viscoelastic dynamics of a crystalline silicon (001) surface using a quadrilateral 

pyramid probe tip. We assume that the tip oscillates above the surface. 

 

First, we create a new project file. Click the item [File] > [New], and you will obtain a dialog box 

named [Create new project]. In the dialog box, [Project name] is blank. Then, type a string 

“test-femafm300” for [Project name], and a new project file, whose name is given by 

“test-geoafm300.pro”, will be generated automatically. 

 

Second, we load the geometrical data of both the tip and the sample material from the item 

[Component]. Click the tab [Setup] in the [Project Editor], and you will find the item [Component] at 

the top of the page. Right-click on the item [Component] and select [Add Tip] > [Pyramid]. Then, a 

dialog box of [angle (deg)] appears to define the angle at the top of pyramid. The parameter, 32.0 

degrees, is given as the default value for the angle, so that we click the [OK] button. Right-click on 

the item [Component] again and choose the item [Add Sample] > [Database]. Then, a database for 

typical materials prepared previously appears. Here, we choose [si001]. 

 

Third, we define a resolution for the finite element method, which will be carried out by the 

FemAFM. Click the tab [FEM] in the [Project Editor], and you will find the item [simulation] > 

[resolution]. Then, you can type the value of the resolution. Here, let us put the resolution at 2.0 

[angstrom]. 

 

At present time, the window displays the following image. 
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Now, we define an area where the tip scans. In fact, [viscoelastic dynamics mode] does not require 

the scanning area because the tip contacts with a specified point. We now set it routinely but note 

that the specified point must be in the scanning area. 

 

Click the tab [Setup], and you will find the item [Sample] > [Size], which tells us that the width, the 

depth and the height of the sample material are given by 14.28665 [angstrom], 13.52978 

[angstrom] and 8.16468 [angstrom], respectively. 

 

Thus, we put the width and the depth of the scanning area at w=”16.0” [angstrom] and d=”16.0” 

[angstrom], respectively. Then, the scanning area includes the sample material completely. 

Moreover, we pay attention to the fact that the resolution (2.0 [angstrom]) can be divided into the 

width and the depth of the area (16.0 [angstrom] and 16.0 [angstrom]) exactly, with nothing left 

over. Thus, we can split the scanning area into squares of the mesh exactly. 

 

The origin of the three-dimensional Cartesian coordinate system is put on the center of a substrate 

where the sample material lies. Thus, under the item [Tip] in the tab [Setup], enter the starting 

point for scanning as [Position] x=”-8”, y=”-8”, z=”6” and specify the scanning area as [ScanArea] 

w=”16”, d=”16”, h=”0”. 

 

After the above operations, right-click on the main window to open a context menu. Then, make a 

tick at the item [Show Scan Area] in the context menu, and you will obtain the following images in 

the main window. A purple rectangle shown in the main window represents the scanning area. 
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Then you should input the physical properties of the tip or the sample, such as Poisson’s ratios, 

Young’s moduli and the Hamaker constants, those are placed at [Setup] tab > [Tip] > [Property] or 

[Sample] > [Property]. The default values are 76.5 [GPa] for [young], 0.22 for [poission], 50 [zJ] for 

[hamaker], which you can change as you like. We here use the default ones. 

 

The other required physical properties are adjustable in [FEM] tab. Input a density of the tip and a 

spring constant of the cantilever in [density] and [spring_constant], respectively, under [Tip] > 

[Property]. The default values are 2329.0 [kg/m3] and 0.05 [N/m], respectively. Input also the 

surface tension in [surface_tension] under [Sample] > [Property], where the default value is 0.108 

[N/m]. We here use the default ones. 

 

We specify the external oscillation of the cantilever in [amplitude] and [frequency] under 

[simulation] in [FEM] tab. Input 150 [angstrom] and 0.5 [GHz], respectively. 

 

We also specify a single point on the surface where the tip contacts with it, by the use of [ix] and 

[iy] under [JKR_position] in [FEM] tab. [ix] and [iy] are the running numbers along x- and y-direction 

of divided cells in the scanning area. [ix] and [iy] start from 1 from the bottom left corner. Now we 

input [ix] = 5 and [iy] = 1. 

 

The last step before starting your simulation is as follows. You assign the number of threads for the 

parallel computing in [OpenMP_threads] in [FEM] tab, where the default value 1 means the single 

thread computing. If you set 4 for [OpenMP_threads], your simulation will be done by four cores. 

There are three choices in [simulation_mode] in [FEM] tab, where we now use “femafm_JKR”.  
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After the above preparations, choose [FEM] at the “Simulator Combo Box”, and select [Calculation] 

at “Calculation/Replay Combo Box” on the toolbar. Then click an arrow icon on the toolbar to start 

the simulation.  

 

After the calculation finishes, the result file “femafm_simulation_tip_delta_force.csv” is created in 

“test-femafm300” folder. You may open the file by Excel or other graphic tools. There are four 

columns; the number of time step, the elapsed time [sec], the displacement [m] of the tip and the 

external force [N] of the tip suffered from the sample. 

 

The next figure shows the definition of the displacement of the tip and the external force. The 

displacement  refers to the depth of the top of the tip, where  = 0 corresponds to the original 

sample surface. The external force of the tip F is positive along outward direction from the surface. 

F is originated from the interaction between the tip and the sample, and does not include the force 

from the cantilever applied by exciting force. 

 

 

The next figure shows the force vs. the displacement of the tip. 

 

δ 

0 

F 
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To see the detail, expand the upper right region ( 1.01.0   [nm], 2.02.1  F [nN]):  

 

 

The tip moves along the red arrow. First, the tip contacts with the sample surface which swells a 

little, and the tip is pushed into the surface. After the tip goes to a point where the adhesion force 

is zero, the tip turns outward from the sample. The FemAFM simulates until the tip is about to 

detach from the sample. 

 

In our example, the spring constant of the cantilever is small, so that the slope of the F- curve is 

almost horizontal where the tip slips in JKR theory range from van der Waals range. The FemAFM 
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does not simulate a process when the tip detaches from the sample. This is because the tip may be 

thrown much far away when the tip slips out to van der Waals range from JKR theory range in case 

of a small spring constant of the cantilever. 
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3  Soft Material Liquid AFM Simulator 

 

 

Introduction 

 

Throughout this section we will explain examples which “Soft Material Liquid AFM Simulator” is 

able to compute. While currently still under development, this simulator calculates followings. 

 

✎ Elastic bending or twisting dynamic of cantilever oscillation. 

✎ Viscous fluid dynamics around the cantilever. 

✎ Resonance curve of the cantilever. 

✎ Tapping on soft material samples 

 

When a cantilever is forced to vibrate in the liquid, it arise the fluid fields by stirred liquid around 

the cantilever. So the cantilever feels strong fluid force during the oscillation. 

 

And the cantilever also feels a force when it taps on soft material sample with its probe tip. Due to 

these forces, the cantilever makes elastic bending or twisting motion. So we have developed a 

numerical simulator that analyzes the dynamics of both elastic bending of a cantilever and viscous 

fluid of liquid around the cantilever. This software used to simulate the cantilever dynamics 

combined with fluid dynamics. And more this is useful for designing and analyzing cantilever 

motion tapping on visco-elastic soft materials as rubbers or surface of cells in liquid. 

 

As the initial setting parameter to execute this simulation, there are three groups of settings; such 

as cantilever, liquid and samples. There are following input parameters 

  

➢Cantilever setting 

・structure（length, width, tilt angle） 

・density, Young’s Modulus, Poisson's ratio 

・amplitude, frequency, twist angle, … 

➢Fluid setting 

3  Soft Material Liquid AFM Simulator 
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 ・density, viscosity 

➢Sample setting 

・structure 

・Young’s modulus, damper, meniscus force 

 

This software can output many kinds of data for further analysis. Time evolution of height, 

amplitude bending force probe tip feels etc. and the resonance curve can be calculated. 

 

 

 

Motion of the cantilever in water 

 

We here introduce an example of LiqAFM simulation where a cantilever is vibrated in water. We can 

view the vibrating motion of the cantilever. 

 

First of all, launch [liqgui.exe] and create a new project file with the name you like. 

 

 

 

The cantilever is shown in the main display on the right, while the setting controller is placed on the 

left. 
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Let us look at [Project Editor] on the left.  

This figure shows the [LIQ] - [Mode 

setting] tab. Now we set the parameters 

indicated by red frames. 

 

① The simulation mode 

② condition of the calculation 

③ setting of multiple threading 

 

At first, select [Point oscillation] at 

simulation mode, where the cantilever 

oscillates a specified number of times at a 

single site. On the other hand, we provide a 

simulation mode where the cantilever scans 

on the sample surface (under development). 

 

 

 

Next, we set the environment as follows. 

 

We can choose one of two environments, [Vacuum] and [Fluid], where the cantilever oscillates. 

We here select [Fluid] because we are to simulate in water. 

 

At last, we set the parallel computing. We can specify the number of threads as follows. 

 

Notice that this parameter is available only for the calculation in the fluid. The fluid calculation is 

very time consuming, so the parallel computing is expected to reduce the calculation time. 

 

We have completed [Mode setting] and turn to edit [Input data] tab, shown below. The 

initial input parameters here are set by default. 

① 

② 

③ 



 88 

 

 

The important items are ④～⑩ indicated by red frames, and the brief descriptions are as follows. 

 

④ setting of fluid 

④ 

⑤

⑥ 

⑦ 

⑧ 

⑨ 

⑩ 
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⑤ setting of material properties of the cantilever 

⑥ setting of the structure of the cantilever 

⑦ setting of oscillation of the cantilever 

⑧ setting the distance from tip to sample 

⑨ setting of material properties of the sample 

⑩ time step of calculation, convergence criteria 

 

This sample project file has the values of water properties at ④ and silicon cantilever at ⑤ in 

advance. If you want to simulate with the other material, modify these values. 

 

⑥ is set the basic structure of the cantilever. If you want to simulate more detail, increase the 

value of [sections]. Keep in mind that the calculation time may be consumed in that case. 

 

At ⑧, we set the distance from the tip point of the needle to the top of sample. Considering the 

cantilever amplitude (⑦ [amplitude]) and the height from sample （⑨ [touch]）, set this 

distance properly where the tip comes across the sample softly enough. 

 

As the calculation in liquid takes much time, adjusting the value at ⑩ will reduce the time. On the 

contrary, the calculation in vacuum finishes comparatively early. 

For example, input about “30” to the [simulation] > [time] > [max_cycles] in case of 

calculation in liquid, and input about “300” to that in case of that in vacuum. 

In [convergence] > [criterion], input “0.0”.  

 

 

 

For details of the other parameters, please refer to the Reference Manual. 

 

We can change the [unit] of several parameters as shown in 

the right figure. When you double-click the unit, then a list of the 

supported units is displayed. Please select one of them you like.  

Note: [um] and [ang] stand for "m" and "Å", respectively. 

 

Finally, we set the structure of the cantilever. Click the [Cantilever] tab as follows. 
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The contents of ⑪~⑬ are, respectively,  

 

⑪ tip position 

⑫ structure of the cantilever 

⑬ structure of hole of the cantilever 

 

We make a shape of the cantilever at ⑫. In the figure below, the gray-colored polygon is the 

cantilever, and the light-green-colored diamond is the tip. The front edge of the cantilever is on the 

right side. 

 

 

As you move the slider bars Ⓐ (horizontal) and Ⓑ (vertical), the front edge of the cantilever will be 

⑪ 

⑫ 

⑬ 

Ⓒ 

Ⓑ 

Ⓐ 
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sharpened. The slider bar Ⓒ transfers the tip position.  

 

In order to make a single slit in the cantilever, we use the [Slit] option. Check [Slit] so that 

you can input a length and a width of the slit in the cantilever. Move the slider bar Ⓓ to transfer the 

slit position. 

 

 

 

The cantilever whose shape has been modified is shown in the main window as follows. 

 

 

 

We have finished the setting mentioned above. Saving the project file, you can start the simulation 

with it. Click [Display] > [Result View] from the menu bar to display the graphic window 

before the simulation. Click the start button, then the calculation starts, and you can see the 

motion of the cantilever. 

Ⓓ 
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The case of the simulation in fluid, fluid velocity around the cantilever is shown as below. 

 

 

When you right-click on the main window, the following pop-up menu opens. 

 

show bar ……………….. show / hide the cantilever 

enlarge motion ………… enlarge the motion of the cantilever 

shrink motion…………… shrink the motion of the cantilever 

show fluid velocity ……..show / hide fluid velocity around the cantilever 
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enlarge velocity ………… enlarge the fluid velocity 

shrink velocity…………… shrink fluid velocity 

 

The calculated results are written in the output files. At the same time, the result is updated on the 

result view.  

 

 

 

The output items are listed below. 

  

Output items File name File format 

Movie of the cantilever motion barmotion.bar Binary 

Fluid velocity (only in liquid mode) fluidmotion Binary 

Time evolution of the tip height height.csv Text (CSV) 

Time evolution of the amplitude of the 

cantilever at specified points 

height_amplitude.csv Text (CSV) 

Force working on the tip tipforce.csv Text (CSV) 

 

The folder path which contains the output files, is shown at the top of the [Result View] window. 

You can open and use those files by Excel or your own application. 

 

We show the simulated result of the time evolution of the cantilever oscillation by changing the 

calculation conditions; x-axis is the time, and y-axis is the height of the front edge of the cantilever 

where the tip is attached. The red line is the simulated result in vacuum without a sample, the 

green line in vacuum with an elastic sample, the blue line in water with an elastic sample. 
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In vacuum without a sample (red line), the cantilever oscillation makes an artistic sine curve. 

Although our simulation assumes a sample as a simple elastic material, you can see the obvious 

modulation of the cantilever motion by tapping a sample. 

 

The next figure shows the difference of the time evolution of the cantilever amplitude between in 

vacuum and in water. 

 

As the calculation proceeds, the amplitude of the cantilever oscillation converges to certain values 

for both cases. Note that an inappropriate initial condition may result in a divergence of the 

amplitude. 

vacuum-free 

vacuum-sample 

liquid-sample 
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We can make a triangle-shaped cantilever and simulate with it as follows. Various kinds of the 

cantilevers will be available before long. 

 

 

 

We now explain the difference between two output files, "height.dat" and "height_amplitude.dat". 

For an illustration, we use a sample project "test_nv_001" at 

"SampleProject/LIQ/non_viscoelastic/". We make a graph of the resulted output files, "height.dat" 

and "height_amplitude.dat", obtained from this project as follows. 

 

 
Illustration of "height.dat", which is the time evolution 

of the tip height. x-axis is the time, and y-axis is the 

 
Illustration of "height_amplitude.dat", which is the time 

evolution of the amplitude of the cantilever. x-axis is the 
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height at the front edge of the cantilever where the tip 

is attached. 

time, and y-axis is the amplitude of the exciting 

frequency caused by an external force. 

 

"height.dat" describes the time evolution of the height at the front edge of the cantilever. On the 

other hand, "height_amplitude.dat" describes the amplitude of the exciting frequency caused by an 

external force. 

 

In the project, the cantilever is oscillated by an external force with a frequency 4.0 [kHz] and an 

amplitude 5.0 [nm]. The figure of "height.dat" tells us that the head of the cantilever starts 

oscillating smoothly from time at t = 0. 

 

However, in fact, the oscillation of the cantilever at around t = 0 is superimposed by a lot of 

components with different frequencies, not only a main frequency at 4.0 [kHz]. These straggled 

frequencies are caused by the inherent frequency of the cantilever itself and by the fluctuation due 

to the resistance of the fluid. Note that the figure of "height.dat" plots data points every 32 steps, 

so we cannot see the small fluctuation. 

 

After a while, a main frequency component of the cantilever converges to 4.0 [kHz] corresponding 

to the exciting frequency caused by an external force. As the system approaches the steady states, 

the noisy frequency component will disappear. The figure of "height_amplitude.dat" demonstrates 

that situation. 

 

 

Frequency spectrum of the cantilever 

 

In this subsection we introduce the frequency spectrum of the cantilever. The frequency spectrum 

of the cantilever amplitude can be obtained by simulating for a sequence of frequencies. 

 

First, create a new project as before, then select [Parameter Scan(Resonance Curve)] at 

[Simulation Mode] on [LIQ] tab in [Project Editor]. Then the items at [Parameter 

Scan] becomes available.  
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Select [Vacuum] at [environment] because we will now simulate in vacuum. In vacuum case, 

[Number of CPUs] is not available because the calculation finishes early. 

 

Next, we set the frequency range. Input the values of [start], [end] and [step] respectively 

from [Parameter Scan] which is the frequency range providing to the cantilever basement. 

 

For example, if you input values as above, the cantilever is oscillated with divided the range from 

20.0 kHz to 50.0 kHz into eleven points. Thus you can set a sequence of frequencies. 

 

We then set [Input data] tab similar to the previous subsection, but note the following three 

items. 

 

The first is ⑦ [motion] – [frequency].  

 

You cannot edit this parameter here, which you have already set at [Parameter Scan] in [Mode 

Setting] tab. 

[kHz]  20.0    23.0    26.0 44.0     47.0    50.0 

Eleven steps every 3 kHz 
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The second is ⑧[DistanceFromSamples]. In this simulation, the tip does not touch the sample. 

In order to keep the tip from the samples far away, change the unit into “mm”. 

 

 

The third is ⑩ [simulation]. In this simulation, the cantilever amplitude should converge at a 

certain level. We, therefore, have to set a large [max_cycles] so that the oscillation repeats a 

number of times. The maximum value is now 100 cycles. Note that it is very time consuming in case 

of the simulation in water. 

 

Input “0.0” at [convergence] > [criterion]. 

 

The other parameters and the shape of the cantilever are the same as the previous subsection.  

 

We are now ready to start the simulation. Save the project, then click the start button. Waiting for a 

while, you can obtain a resonance curve in [Result View] as follows. 

 

The horizontal axis represents frequency [Hz], and the vertical axis represents the amplitude [m].  

 

When you examine the detailed behavior around the resonance frequency, change the frequency 

range and the number of steps, and simulate again. 
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The next graph shows the frequency spectrum of the cantilever. These lines are results of three 

conditions, in vacuum, in air, and in water respectively. Thus the resonance frequency shifts by 

condition. 

 

 

 

As a summary, we have developed a numerical simulator for cantilever dynamics strongly combined 

with fluid dynamics. We consider this simulator is useful for designing and analyzing cantilever 

motion tapping on soft materials in liquid. 

 

Cantilevers having complex shapes 

Recalculate around the circled range. 
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In this subsection, we explain how to design cantilevers that have complex shapes. As s concrete 

example, we use a project file, “test_nv_002.pro”, which is put into the directory, 

“/non_viscoelastic/test_nv_002”. 

 

In this project file, the cantilever is given as the following figure: 

 

 

The shape of the cantilever shown in the above figure is described with elements surrounded by 

tags <bar><structure> and </structure> in the project file. The elements given by the tags 

<bar><structure> and </structure> in “test_nv_002.pro” are as follows: 

<body display="false"> 

<section display="false">0.0 1.0 1.0</section> 

    <section display="false">0.75 1.0 1.0</section> 

<section display="false">1.0 0.4 1.0</section> 

</body> 

<split display="false"> 

<section display="false">0.125 0.0 0.1</section> 

<section display="false">0.25 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.125 0.25 0.35</section> 

<section display="false">0.25 0.25 0.35</section> 

</split> 

<split display="false"> 

<section display="false">0.375 0.0 0.1</section> 

<section display="false">0.5 0.0 0.1</section> 

</split> 
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<split display="false"> 

<section display="false">0.375 0.25 0.35</section> 

<section display="false">0.5 0.25 0.35</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.0 0.1</section> 

<section display="false">0.75 0.0 0.1</section> 

</split> 

<split display="false"> 

<section display="false">0.625 0.25 0.35</section> 

<section display="false">0.75 0.25 0.35</section> 

</split> 

 

To define the complex shape of the cantilever, you have to take care of the following points. Looking 

at the above figure of the cantilever, we notice that the cantilever is divided into eight parts with 

equal lengths along the beam. Thus the cantilever is constructed with eight blocks, whose lengths 

of sides along the beam are equal to one eighth of whole length of the cantilever. 

 

To simulate the dynamics of the cantilever with finite difference equations, it is convenient to divide 

the cantilever into blocks, whose number is equal to a multiple of eight. Moreover, the solver of the 

software requires that the domain is made separate into parts more than twice as much as 

appearance of blocks shown as the previous figure. Hence, in the present case, we have to divide 

the cantilever along the beam into parts, whose number is a multiple of eight and equal to or larger 

than sixteen. From these reasons, we divide the cantilever into thirty-two parts along the beam. 

 

Then, we have to write down the number “32” into the project file, “test_nv_002.pro”, as the 

number of grid points along the beam. We define this number with a tag, <sections>, which is 

located after the <bar><structure> tag. Here, we have to pay attention to another point. When we 

specify the number of grids with the <section> tag, we write actually down the number which is 

equal to one plus the number of grids. Thus we have to describe “<section>33</section>” in the 

project file. 

 

Finally, we explain a relation between the visualization of the flow velocity and the number of grids. 

As shown in the following figure, during both the “Replay” and the “Calculation” modes, time 

evolution of movement of the cantilever and flow velocity are drawn in the main window. The 

velocity fields of the fluid are sketched on cross sections being perpendicular to the cantilever. 
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Every cross section is put at four-grid-point interval. Thus, if you let the number of grids, which 

divide the cantilever along the beam, be equal to a multiple of four, the image shown in the main 

window becomes favorable. Hence, you had better input the number, being equal to a multiple of 

four plus one, to the <bar><structure><sections>tag in the project file. 

 

 

 

 

Simulation with viscoelastic dynamics 

 

In this subsection, we explain how to simulate viscoelastic dynamics of the cantilever’s tip and a 

sample, which exhibits both viscous and elastic characteristics. The Soft Material Liquid AFM 

Simulator prepares an option for carrying out simulation of the viscoelastic dynamics. Using this 

option, the Johnson-Kendall-Roberts (JKR) theory is assumed for describing the contact dynamics of 

the cantilever’s tip and the viscoelastic sample, and we can treat adhesion phenomena caused by 

surface tension of the samples. If we use this option, for example, we can output time evolution 

data of external force that the viscoelastic sample exerts on cantilever’s tip at ease. 

 

Sample projects for simulating viscoelastic contact dynamics are put in the directory, “/viscoelastic”. 

As shown in the following table, three project files are prepared. You can use them in accordance 

with your various purposes. 

testp_v_001 AFM in vacuum environment. Young’s modulus of the cantilever is small. 
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testp_v_002 AFM in vacuum environment. Young’s modulus of the cantilever is large. 

testp_v_003 Liquid-environment AFM. Young’s modulus of the cantilever is large. 

 

To carry out the simulation of AFM with viscoelastic contact dynamics, we need to describe some 

important parameters in the project files. We explain them in the following table. 

<LIQ><fluid><material><kviscosity> Kinematic viscosity of the fluid. Its unit is 

[m^2/s]. 

<LIQ><fluid><material><density> Density of the fluid. Its unit is [kg/m^3]. 

<LIQ><fluid><material><impulse> Impulse of force that molecules give to the fluid 

at random. Its unit is [N/ms]. 

<LIQ><bar><material><density> Density of material used for making the 

cantilever. Its unit is [kg/m^3]. 

<LIQ><bar><material><young> Young’s modulus of material used for making 

the cantilever. Its unit is [GPa]. 

<LIQ><bar><material><poisson> Poisson’s ratio of material used for making the 

cantilever. It is dimensionless. 

<LIQ><bar><material><friction> Coefficient of friction of material used for 

making the cantilever. It is dimensionless. 

<LIQ><bar><material><hamaker> Hamaker constant of material used for making 

the cantilever. Its unit is [J]. 

<LIQ><bar><structure><tip><radius> Radius of the tip of the cantilever. Its unit is 

[nm]. 

<LIQ><bar><motion><frequency> Frequency of the oscillation of the cantilever 

with external force. Its unit is [kHz]. 

<LIQ><bar><motion><amplitude> Amplitude of the oscillation of the cantilever 
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with external force. Its unit is [nm]. 

<LIQ><bar><motion><baseheight> Distance between the surface of the sample and 

the center of the cantilever in the initial 

position. Its unit is [nm]. (To let the tip of the 

cantilever touch the surface of the sample, it 

has to be nearly equal to the amplitude of the 

oscillation of the cantilever.) 

<LIQ><bar><DistanceFromSamples> Put a value which is equal to <baseheight>. Its 

unit is [nm]. 

<LIQ><sample><material><point> 

<young> 

Young’s modulus of the sample. Its unit is [GPa]. 

<LIQ><sample><material><point> 

<poisson> 

Poisson’s ratio of the sample. It is 

dimensionless. 

<LIQ><sample><material><point> 

<damper> 

Damping coefficient of the sample. Its unit is 

[Ns/m]. (This coefficient is made use of to 

generate the damping force, which is linearly 

dependent upon the velocity.) 

<LIQ><sample><material><point> 

<tension> 

Tension between the tip of the cantilever and 

the sample when they touch. Its unit is [uN]. 

<LIQ><sample><material><point> 

<touch> 

Distance between the surface of the sample and 

the tip of the cantilever in the initial position. It 

has to be less than zero. (Multiply the value of 

<basehight> by (-1) and put it.) Its unit is[nm]. 

<LIQ><sample><material><point> 

<detach> 

Distance between the point where the tip is 

released from sample and the initial position of 
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the tip of the cantilever. It has to be less than 

zero. (Put a value being equal to the value of 

<touch>.) Its unit is [nm]. 

<LIQ><sample><material><point> 

<hamaker> 

Hamaker constant of the sample. Its unit is [J]. 

<LIQ><sample><material><point> 

<adhesive> 

The surface tension of the sample. Its unit is 

[N/m]. 

<LIQ><simulation><time> 

<max_cycles step="smooth">1.6 

A period of the cycle of the cantilever’s 

oscillation caused by the external force during 

the whole simulation. It is dimensionless. A 

suitable value of this quantity is 1.6 around. 

<LIQ><Output><Directory> 

<delta_tipforce where="head" interval="1" 

displaytype="1D" 

ctrl="label">delta_tipforce.csv 

Time evolution of a distance and forces of 

attraction and repulsion between the 

cantilever’s tip and the sample is output into a 

file, “delta_tipforce.csv”. 

 

We can carry out simulation of viscoelastic contact dynamics in the following manner. First, look at 

the project editor window put in the left-hand side of the GUI. Then we find the “viscoelaticity” 

button located under the “LIQ->Mode setting” tab. Second, we click the “viscoelaticity” button and 

let it be an “on” state. (In the default setting, it is an “off” state.) Third, click the arrow icon to start 

“Calculation” as similarly to the other solvers. 

 

 

For example, let us carry out the simulation with the project file, “ testp_v_002.pro”, which is put in 

the sample project folder, “/viscoelastic/testp_v_002”. Then, we obtain the following force curve 

from the output file, “delta_tipforcr.csv”. (The following figure is saved in the file, 
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“delta_tipforce_ref.xlsx”, which is put in the sample project folder, 

“ /viscoelastic/testp_v_002/output”.) 

 

 

In the above graph, relation between the displacement of the cantilever’s tip and the external force 

applied to the tip is plotted. The vertical and horizontal axes represent the external force and the 

displacement, respectively. The tip is in contact with the sample. The spring constant of the 

cantilever is large and the AFM measurement is performed in vacuum. As shown in the following 

figure, the origin of the displacement is put on the surface of the sample and the z-axis points down. 

The positive axis of the external force points upwards. 

 

As a summary, we have developed a numerical simulator for cantilever dynamics strongly combined 

with fluid dynamics. We consider this simulator is useful for designing and analyzing cantilever 

motion tapping on soft materials in liquid. 
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4  Classical Force Field AFM Simulator 

 

 

Introduction 

 

In this section, we will introduce the examples of the simulation using the Classical Force Field 

AFM simulator. The simulator calculates the tip-sample interaction and considers the deformation 

of the molecule. The simulator has two method to calculate the molecular deformation, one of 

which you can choose. 

 

1. CG-AFM Simulator: Get the stable conformation of a molecule by searching the energy 

minimum of the molecular system. 

2. MD-AFM Simulator: Monitoring the time evolution of a molecular conformation by 

calculating the Newton’s equation of motion. 

 

Calculation procedures of these simulators are roughly as follows. 

 

1. Select the model tip and sample, and set each position. 

2. Set the input parameter. 

3. Simulate and view the result. 

 

For more information about the input parameter, see the “reference manual”.  

 

 

Example of calculating the frequency shift image of pentacene in 

vacuum 

 

We introduce the atomic scale AFM simulation in vacuum environment by using CG-AFM 

Simulator. The sample project file of this example is saved as 

“SampleProject\CG\NC_pentacene\NC_pentacene.pro”. 

We will simulate AFM images by the use of a pentacene molecule as a sample, and a CO 

molecule as a modified tip. We assume the pentacene molecule keeps its conformation, and fix the 

positions of the all atoms of the molecule. 

4  Classical Force Field AFM Simulator 
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You can edit and set the input parameters in the “Project Editor” on the left of the window. The 

key parameters are listed below. (See the reference manual for more information.) 

 

1. Initial tip position 

2. scanning area (Setup  Tip  ScanArea) 

3. environment of the simulation system (CG  AFMMode) 

4. scan mode (CG  Tip_Control  scanmode) 

5. pixel size (CG  Tip_Control  delta_xy) 

6. number of tip movement toward z-axis (CG  Tip_Control  NC_Mode_Setting  

ThetaStepNumber) 

7. tip amplitude (CG  Tip_Control  NC_Mode_Setting  TipZamplitude) 

8. spring constant of cantilever (CG  Tip_Control  NC_Mode_Setting  SpringConst) 

9. resonance frequency (CG  Tip_Control  NC_Mode_Setting  ResoFreq) 
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You may view the result of the frequency shift image at “Result View”. (Select the menu bar  

“Display”  “Result”, and select “cgafm_frq.csv” at the upper box on “Result View” window.) 

 

 

 

Example of calculating force curve in aquatic environment 

 

Next, we introduce the example of the CG-AFM calculation in aquatic environment. The sample 

project file of this example is saved as ‘SampleProject\CG\HOPG_RISM\HOPG_RISM.pro’. The tip 
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model is a carbon nanotube, and the sample is a graphene sheet (HOPG). In this calculation, we 

assume these structures are not deformed. Therefore, we set to fix all the atoms in the structures. 

 

 

 

We can set the input parameters from the ‘Project Editor’, which is on the left side of the GUI. 

When we want to simulate under the aquatic environment, we need to set the value of the system 

environment (column ‘AFMMode’ in the CG-tab) to be ‘CG_RISM’. Moreover, we need to check the 

value for all the parameters because almost all the parameters affect the result of the simulation 

under the aquatic environment. As for the meaning of the parameters, see the reference manual. 

We show the results of the force curve (left panel in the figures below) and the variation of total 

free energy of the system (right panel) when we gradually decrease the tip-sample distance. We can 

see the vibrational behavior, which is the typical feature of the AFM measurement under the 

aquatic environment. 

This CG-AFM solver outputs the result of the calculated solvent-solvent correlation function, 

whose file name is ‘CG_RISM_Corr_VV.csv’ in the output directory. (However, we cannot view the 

data in this file by the result view in the GUI. 
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Example of calculating force curve of chain alkane 

 

We introduce the atomic scale and dynamical AFM simulation by using MD-AFM Simulator. The 

sample project file of this example is saved as 

“SampleProject\MD\FCurve_octane4\FCurve_octane4.pro”. 

We simulate the force curve by the use of four octanes as the sample, and a CNT molecule as the 

tip. We assume the lower edges of the octanes are bonded on the substrate, so that we make the 

position of the bottom atoms fixed. The four octanes are evenly distributed on the substrate. The 

simulator calculates a force onto the tip during the CNT tip comes close to the molecules on the 

substrate. 

 

 



 112 

You can edit and set the input parameters in the “Project Editor” on the left of the window. The 

key parameters are listed below. (See the reference manual for more information.) 

 

① Initial tip position (Setup  Tip  Position ) 

② scanning area (Setup  Tip  ScanArea  h) 

③ Initial samples position (Setup  Sample  Position ) 

④ scan mode (MD  Tip_Control  scanmode) 

⑤ pixel size (MD  Tip_Control  delta_z) 

⑥ time step (MD  MD_Setting  TimeStep) 

⑦ step number (MD  MD_Setting  StepNumber) 

⑧ temperature (MD  MD_Setting  Temperature) 

 

You may view the result of the frequency shift image at “Result View”. (Select the menu bar  

“Display”  “Result”, and select “fz.csv” at the upper box on “Result View” window.) 
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You can view the simulated movie of the tip and the samples when you select “Replay” mode and 

click the Play button. 
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5  Quantum Mechanical SPM Simulator 

 

 

Introduction 

 

In this section, we introduce some case studies calculated by “Quantum Mechanical SPM Simulator”. 

The project files for these studies are included in the package of the software. The calculation 

procedure in this simulator is roughly described as follows: 

 

i. Set up the tip and the sample models (in the “Setup tab”) 

ii. Set up the other input parameters (in the “DFTB tab”) 

iii. Start calculation 

iv. After the calculation, see its results 

 

We have described how to operate the Graphical User Interface software in the previous section. 

For more information about the input parameter, see the “reference manual”. 

 

 

Example of AFM (frequency shift) image simulation 

 

First, we introduce the example of AFM (frequency shift) image simulation, whose function is 

equipped in the other simulators in our software. (The project file of this example is 

“SampleProject\DFTB\afm_hsi\afm_hsi.pro”)  You can use this simulator when you would like to 

analyze the AFM related physical quantities precisely. 

 

H 

Si 

5 Quantum Mechanical SPM Simulator
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In this simulation, we use the modeled Si tip apex hydrogenated and the hydrogenated Si(001) 

surface. 

We comment on the important parameters in this example. Most important ones are enclosed by 

the red squares. (When we simulate on another system, we need to pay attention to the other 

parameters, which are not enclosed by the red squares. Please refer to our “reference manual” for 

confirming their meaning.) 

 

① Starting point of the scanning region 

② Size of the scanning region. When we want to calculate the value of the frequency 

shift, please set the value of the tag “h” to be larger than 0. 

③ Calculation mode. Choose “DFTB_AFM”. 

④ Physical parameters for cantilever 

⑤ Parameters for the macroscopic figures of the tip 

Note. We cannot calculate the relaxation of the structures at now. 

 

 
We can see the image of the frequency shift simulated on this setting by using our Result View in 

① 

③ 

④ 

⑤ 

② 
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the GUI (see the figure below). In this setting, when the tip position is on the hydrogen atoms of the 

surface, the value of the frequency shift is larger than the other tip position. It is because that the 

attractive force between the tip and the surface enlarges on such tip positions.  

 

 

 

 

 

Examples of STM simulation 

 

(1)  Simulation for a tunneling current image 

 

Next, we introduce two example of STM simulation, whose function is not equipped in the other 

simulators in our software. The first example is the image calculation of the tunneling current. (The 

project file of this example is “SampleProject\DFTB\stm_hsi\stm_hsi.pro”)  

In this simulation, we use the modeled Si tip apex and the hydrogenated Si(001) surface with one 

defect. 



 117 

 

 

We comment on the important parameters in this example. Most important ones are enclosed by 

the red squares. (When we simulate on another system, we need to pay attention to the other 

parameters, which are not enclosed by the red squares. Please refer to our “reference manual” for 

confirming their meaning.) 

 

① Starting point of the scanning region 

② Size of the scanning region. The value of the tag “h” forces to be 0. 

③ Calculation mode. Choose “DFTB_STM”. 

④ Tip voltage. (In case of “DFTB_STM” mode, the value of the tag “minimum” is used.) 

⑤ Division number of k-points in samples’ Brillouin zone for calculating samples’ states. 

 

H 

Si 

There is a defect in this column. 
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We can see the image of the tunneling current simulated on this setting by using our Result View 

in the GUI (see the figure below). In this setting, when the tip position is on the hydrogen atoms of 

the surface, the value of the frequency shift is larger than the other tip position. It is because that 

the attractive force between the tip and the surface enlarges on such tip positions. The value of the 

current enlarges when the tip position is on the defect, where there is a dangling bond. 

 

① 

② 

③ 

④ 

⑤ 



 119 

We compose four other project files for image simulation of the tunneling current in the package.  

Si tip and Si(111) DAS 7x7 surface:  

SampleProject\DFTB\stm_das7\stm_das7.pro, 

Fullerene tip and Si(111) DAS 7x7 surface: 

SampleProject\DFTB\stm_das7_c60\stm_das7_c60.pro, 

Si tip and Si(001)-2x1:H surface: 

SampleProject\DFTB\stm_si001_2x1h\stm_si001_2x1h.pro, 

Si tip and Si(001)-3x1:H surface: 

SampleProject\DFTB\stm_si001_3x1h\stm_si001_3x1h.pro. 

 

 

(2)  Calculation of Scanning Tunneling Spectroscopy 

 

The second example is the calculation of the scanning tunneling spectroscopy. (The project file of 

this example is “SampleProject\DFTB\sts_si001_3x1h\sts_si001_3x1h.pro”)  

In this simulation, we use the modeled Si tip apex and the Si(001)-3x1:H surface. 

 

 

 

We comment on the important parameters in this example. Most important ones are enclosed by 

the red squares. (When we simulate on another system, we need to pay attention to the other 

parameters, which are not enclosed by the red squares. Please refer to our “reference manual” for 

confirming their meaning.)  
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① Tip position (Calculation is done only at this position in the STS mode.) 

② Calculation mode. Choose “DFTB_STS”. 

③ Tip voltage. (Minimum value, maximum value, and division number between them.) 

④ Division number of k-points in samples’ Brillouin zone for calculating samples’ states. 

 

 

 

We can plot the results of the tunneling current and its spectrum simulated on this setting by 

using our Result View in the GUI (see the figures below). The left figure is the I-V curve, and the 

right one is the differential conductance curve (dI/dV)/(I/V) - V. The voltage V of the horizontal axis 

is the tip bias compared to the sample one. 

 

① 

② 

③ 

④ 
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Simulation for a KPFM simulation 

 

We introduce one example of KPFM simulation. (The project file of this example is 

“SampleProject\DFTB\kpfm_c6\kpfm_c6.pro”)  

In this simulation, we use the modeled Si tip apex hydrogenated and the Si(001)-c(4x2) surface. 
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We comment on the important parameters in this example. Most important ones are enclosed by 

the red squares. (When we simulate on another system, we need to pay attention to the other 

parameters, which are not enclosed by the red squares. Please refer to our “reference manual” for 

confirming their meaning.) 

 

① Starting point of the scanning region 

② Size of the scanning region. The value of the tag “h” forces to be 0. 

③ Calculation mode. Choose “DFTB_KPFM”. 

④ Charge neutrality of tip. (Minimum value, maximum value, and division number 

between them.) Note that we cannot use the bias as the control parameter because 

of our adopted calculation model. 

 

 
 

We can see the image of the local contact potential difference simulated on this setting by using 

our Result View in the GUI (see the figure below). In this setting, we can see the region with the 

large potential difference. This region coincides with the lines connecting the up dimer Si atoms.  

① 

③ 

④ 

② 
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We compose three other project files for KPFM image simulation in the package. 

Si tip and Si(001)-c(4x2) sample surface, but with a different tip-sample distance : 

SampleProject\DFTB\kpfm_c4 \kpfm_c4.pro, 

Si tip and Si(001)-c(4x2) sample surface with an impurity: 

SampleProject \DFTB\kpfm_n6\kpfm_n6.pro, 

SampleProject\DFTB\kpfm_n4\kpfm_n4.pro. 

 

band calculation 

 

Finally, we introduce an example of band calculation. 

In this calculation, we use titanium dioxide as a sample. 
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We comment on the important parameters in this example. Most important ones are enclosed by 

the red squares. (When we simulate on another system, we need to pay attention to the other 

parameters, which are not enclosed by the red squares. Please refer to our “reference manual” for 

confirming their meaning.) 

 

① Calculation mode. Choose "DFTB_BAND". 

② Band calculation parameters (lattice type, division number of k-points, and division 

number of lines.) 
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We can see the band structure on this setting by using out Result View in the GUI (see figure 

below).   

 

 

  

① 

② 
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Chapter 4 

Image Comparison 
 

 

 

1  Overview 

 

 

When we use the GUI-module for comparing between measured images and simulated images (we 

call ‘Analyzer-module’ below), we can display and visualize various data formats such as the 

measured SPM image data, the output data from various analyzing software, the result data of our 

SPM Simulator, and the image data captured from scientific papers. We can easily compare these 

images by displaying them in parallel. Moreover, we can use this module as software to transform 

the data format because this module can save the inputted data as your favorite format. This 

module also equips the functions to correct inclination of an image automatically, to estimate a tip 

shape, and to remove influences of tip shape included in a measured image. We can use the 

functions of the Fourier analysis, the high-resolutionization algorithm, and the neural-net analysis. 

Furthermore, the ‘Analyzer-module’ provides several functions as the digital image processing tool; 

such as the binary image generation using a threshold, the contrast adjustment (gamma correction), 

the edge extraction (Sobel filter processing) and the noise reduction (median filter processing). 

  

Simulation images 

Simulators 

MD 

FEM 

DFTB 

CG 

LIQ 

GEO 

Software for 

analysis 

Measured image 

SPM  
(hardware
) 

Analysed image 

Figure in paper, 

Captured image 

Parallel displaying 

Analyzer 

1  Overview 
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2  Part names and functions 

 

 

The followings are the explanations about main functions in each part. 

 

Image View 

Menu Bar & Tool Bar 

Cross Section View 

Data View 

Image View 

Image View 

Analyzer 

2  Part names and functions 
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【Analyzer】 

The name of the entire window. 

 

【Menu Bar & Tool Bar】 

Bars for the operation to input and save the file, and for the operation to align and close the 

sub-windows 

 

【Image View】 

Windows to visualize an input data as a 2D or 3D image. We can change the point and the size 

of view by the mouse and keyboard operations. In the windows we can set a cut plane by the 

mouse operation. The cross section is displayed on the Cross Section View. As we can see, we 

can display multiple windows of the Image View simultaneously and align them in parallel. 

 

【Cross Section View】 

Window to display the cross section that is specified in an Image View. 

 

【Data View】 

Window to display the data content as the tabulated text format. 

 

 

 

3  Start up and quit Analyzer-module 

 

 

【Start up】 

 

 

3  Start up and quit Analyzer-module 
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1. Select “Menu Bar” in the main GUI  [Tool]  [Analyzer] 

 

A window for Analyzer-module is started up by the above operation. 

 

【Quit】 

 

 

1.  Select “Menu Bar” in the Analyzer-module  [File]  [Exit]  

 

The Analyzer-module quits and the window is closed, though the main GUI does not quit by this 

operation. 

 

 

4  File manipulations 

 

 

In the Analyzer-module, we can input not only image data measured by various SPMs, but also 

result data from our SPM Simulator, image data captured from scientific paper, and other ones. Also, 

we can convert the input data to another format and save it. Moreover, this module has a function 

4  File manipulations 
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to capture the visualization on Image View as to a picture file. In this section, we explain how to 

operate to input and save the data file, and to capture the visualization. 

 

Input the data file 

【Input via the file dialog】 

 

1.  Select “Menu Bar”  [File]  [Open]41. (Displayed the “Open File” dialog) 

2.  Choose the file you want to open  push [Open] 

                                                             
41 We can also perform this operation by clicking the “Open” icon on the “Tool Bar”. 

Image View 
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In the Analyzer-module, we can open the picture files of the general format (jpeg, bmp, png, tif）, 

the Cube-like format (the output format of this SPM Simulator), and the files of the format adopted 

by the SPM hardwares and the analyzation softwares (Unisoku, Omicron, Gwyddion, WSxM, SPIP, 

Asylum, Surf). After the data file chosen on the dialog is loaded without error, the Image View 

window is emerged. On the window, a 2D-image42 generated from the data file is displayed. 

 

【Input from the “Recent Files” menu】 

 

1.  Select “Menu Bar”  [File]  [Recent Files]  a list of data file43  choose a data file 

 

【Input of a file of the general picture format】 

The file of a general picture format such as gif and jpg has information of the brightness, which is 

not the information of the tip-height on the SPM measurement. Thus, when we input a file of the 

general picture format, we need to specify the correspondence relationship between the value of 

the brightness and that of the tip-height. In addition, we need to set the scale of the picture in real 

system. In this subsection, we explain how to input such kind of the files. 

                                                             
42 We describe how to change styles of the visualization in the following sections. 
43 The maximum number of the files in the list is 10. 
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1.  Select “Menu Bar”  [File]  [Open]44  Displayed “Open File” dialog 

2.  Choose the data file  Push [Open] 

3.  Displayed “Set scale” dialog  Input the data “Distance between pixels”  Push [OK] 

4.  Displayed “Set Value Range” dialog  Input the data “value range”  Push [OK] 

 

We can set the pixel size in real system (Å) from the “Set scale” dialog. Similarly, we can set the 

difference in height in real system (Å), which corresponds to the difference of the brightness 

between black and white in the picture, from the “Set Value Range” dialog. 

 

Save the data file 

 

In Analyzer-module, we can save the input data as the file with another name and another format. 

 

                                                             
44 We can also perform this operation by clicking the “Open” icon on the “Tool Bar”. 
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1. a.  “Manu Bar”  [File]  

  b.  Right click on “Image View”45  “Context menu” is displayed. 

2.  Select [Save As]46  “Save As” dialog is displayed  input a file name  Push [Save] 

 

 

Save the image 

 

We can capture the visualization on Image View as to a picture file. 

                                                             
45 When there are the Image View windows on the module, we need to right click on the window 

displayed the data that we want to save. 
46 We can also perform this operation by clicking the “Save” icon on the “Tool Bar”. 
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1. a.  Select “Manu Bar”  [File]  

  b.  Right click on “Image View”  “Context menu” is displayed. 

2.  Select [Export Image]47  “Export Image” dialog is displayed  input a file name  Push 

[Save] 

 

 

 

5  Fourier analyses and high-resolutionizing of images 

 

 

We can do image-processing by the Fourier analysis and high-resolutionizing of images by the 

Lanczos interpolation algorithm. 

 

Fourier analysis of an image 

 

【Draw data】 

 

 

                                                             
47 We can also perform this operation by clicking the “Export Image” icon on the “Tool Bar”. 

5 Fourier analyses and high-resolutionizing of images 
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1. Right click on “Image View”  “Context menu” is displayed  Select [Image Processing]  

“Image Processing View” is displayed 

2. Select “Cartesian”/“Fourier”/“Power Spectrum” from “Mode Combo Box” on “Tool Bar” 

 

We can switch the displayed content by using the “Mode Combo Box” among “Cartesian” 

(real-space image), “Fourier” (Fourier-space image48), “Power Spectrum” (plotting of the power 

spectrum49). 

 

【Image-processing】 

                                                             
48 The scale of the Fourier-space image is logarithmic one. 
49 The power Spectrum is plotted on the log-log axes. 

Image Processing View 

Mode Combo Box 

Cartesian Fourier Power Spectrum 
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We can change the slope of the power spectrum by moving the handle of the “Slider Bar”. As we 

move the handle, both the real and the Fourier space images change. When we move the handle to 

left (right), we obtain the image on which the low (high) frequency component is emphasized. 

Slider Bar 

Cartesian Fourier Power Spectrum 

Reset 

High pass filter 

Low pass filter 
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When we push the [Reset] button, the handle is set to the origin and we obtain the original image. 

 

【Correction of the tone】 

 

 

1. Right click on “Image Processing View”  “Context menu” is displayed  Select [Tone 

Correction]  

 

The menu [Tone Correction] is a toggle-button. Thus, we can change the on and off of the tone 

correction by clicking the button one by one. 

 

【Export to Analyzer-module】 
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1. Right click on “Image Processing View”  “Context menu” is displayed  Select [Export to 

Analyzer]  

 

By this operation, we can export the image on the “Image Processing View” window to the image 

on the “Image View” in Analyzer-module. The data is automatically saved as the file of the Cube-like 

format. 

 

High-resolutionize of an image 

 

 

 

 

1.  Push [Up Resolution / Down Resolution] on “Tool Bar” 

 

By pushing [Up Resolution / Down Resolution] button, we can increase / decrease the resolution of 

Up Resolution / Down Resolution Button 

 

High-resolutionized image 

Picture size 

Picture size 
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the image50. The size of the image is displayed in the textbox on the right of “Tool Bar”. 

 

 

 

6  Neural-net simulator 

 

 

The neural-net simulator learns the relation between two inter-related image data, such as the 

original and observed data, and the low and high resolution data. For example, consider that we 

force the simulator to learn the relation between the known standard sample structure data 

(trainer data) and the tip-height data measured by a SPM (input data). In this case, we consider that 

the network learns the effect of the tip shape to the measured SPM image data. After the learning, 

when we input the image data measured by the tip same as above to the network, we can obtain 

the image data from which the effect of the tip-shape is removed. 

 

 

 

 

                                                             
50 We use the interpolation of the Lanczos filter algorithm. 

 

Sample SPM Image Tip 
Measuremen

t 

Process 
Known sample data Known structure data Neural net Learning 

Process 
Estimated sample Arbitrary SPM image Neural net Estimation 

Process 

Neuralnet Simulator 

Image 1 Image 2 

Learning the relation 

between the image 1 and 2 

6  Neural-net simulator 
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Start up the Neural-net Simulator 

 

 

1. Select as follows on the Analyzer-module: “Menu Bar”  [Tool]  [Neuralnet Simulator] 

 

Settings of the data to learn 
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1. Operate as follows on the Neural-net Simulator: “Menu Bar”  [File]  [Open]51  choose 

                                                             
51 We can also perform this operation by clicking the “Open” icon on the “Tool Bar”. 

input image 

trainer image 

Select original images dialog 

 

Select observed images dialog 

 

Training Data Set window 
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the input data on “Select observed images” dialog  [Open] 

2. Choose the trainer data on “Select original images” dialog  [Open] 

 

The data to learn are set to the neural-net simulator by the above operation. We can set multiple 

input/trainer data though the number of the data must be equal each other. The images of the data 

are displayed on the right of the simulator window (upper: the input image, lower: the trainer 

image). When we set the multiple data, only one pair of the image is displayed.  

 

Start up, quit, and pause the learning 

 

【Start up】 

 

1.  Select “Tool Bar”  [Start] 

 

 When we push the [Start] button, the learning by the neural-net simulator starts. The message 

from the simulator is displayed on the Log View window. 

  

【Quit/Pause】 

Start 

Log View 
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1. Select “Tool Bar”  [Stop/ Pause] 

2. Select “Menu Bar”  [Display]  [Error View] 

 

When we start the learning, the [Start] button cannot become unavailable and the [Stop] and 

[Pause] buttons become available. If we push the [Stop] button, the learning process stops and the 

learning is initialized. If we push the [Pause] button, we can pause on the learning process. When 

we want to restart, we push the [Start] button. On pausing we can check the time dependence of 

the mean square error (MSE) between the output data from the neural-net and the trainer data 

from the “Error View”. The value of the MSE in each time also shows on the “Log View”. 

 

Save and load the result of learning 

 

【Save】 

When the neural-net learning stops, we can save the result of the learning at that time52. In this 

subsection, we explain how to save this result. 

                                                             
52 If we push the [Stop] button at this time, the learning is initialized. Thus, we need to save the 
result of the learning before we push the [Stop] button. 

Stop Pause 

Error View 
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1. Operate as follows: “Menu Bar”  [File]  [Save Weight File]  “Save Weight File” dialog is 

displayed 

2. Input a file name to save  Push [Save] 

 

【Load】 

The neural-network can load the saved result file of the learning. In doing so, we can reproduce the 

condition of the learning when the file is saved. 

 

 

 

1. Operate as follows: “Menu Bar”  [File]  [Load Weight File]  “Load Weight File” dialog is 

displayed 

2. Input a file name to load  Push [Open] 

 

Check the result of the learning / trial to another input data 

 

Save Weight File dialog 

Load Weight File dialog 
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【Check of the result】 

 

 

1. Select “Tool Bar”  [Check]  ”Input Image/Reconstructed Image/Difference Image” 

 

When the neural-net learning stops, we can check the result of the learning visually. When we push 

the [Check] button on the Tool Bar, the images of the input and result (reconstructed) data are 

displayed. Also, the difference image between the result data and the trainer data is displayed. 

 

【Trial to another input data】 

 

Input Image Reconstructed Image Difference Image 
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1. Select “Tool Bar”  [Trial]  “Open File” dialog is displayed 

2. Input a file name of data for trial   Push [Open]  “Input Image/Reconstructed 

Image/Difference Image” 

 

When the learning is finished, we can check the neural-network by using new data that is different 

from the input one. We can input the new data from the “Open File” dialog that is displayed by 

selecting the [Trial] button on the “Tool Bar”. Then, the new data is inputted to the network at this 

time and its reconstructed image is displayed. 

 

Show/Hide of the window, erase the Log View data 

 

Open File dialog 

Input Image Reconstructed Image 
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【Show/hide of the window】 

1. Select “Menu Bar”  [Display]  [Training Data Set / Input Image / Reconstructed Image / 

Difference Image / Error View] 

 

When we want to show/hide a window, we check its title in the [Display] menu. Each [Training Data 

Set / Input Image / Reconstructed Image / Difference Image / Error View] buttons are the toggle 

ones. By repeating the click, we can switch the display / non-display of the window corresponding 

to the button.  

 

【Erase the Log View data】 

Input Image 
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1. Select “Tool Bar”  [Clear]  

 

The [Clear] button on the “Tool Bar” makes the “Log View” cleared. 

 

 

 

 

7  Estimation of tip shape / Removal of tip-shape influence 

 

 

We can estimate the tip shape using only the measured data. Moreover, we can reproduce the 

image on which the effect of the tip shape is removed from the measured data. 

Clear 

Log View 

7  
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Estimation of the tip shape 

 

 

1. Right click on “Image View”  Context menu is displayed  Select [Tip Estimation] 

2. Input the number of pixels in x-axis direction from “Tip Nx” dialog  Push [OK]  

3. Input the number of pixels in y-axis direction from “Tip Ny” dialog  Push [OK] 

4. Input the tolerance of the tip size from “Parameter” dialog  Push [OK] 

 

After loading a measured data on the “Image View” window, we select the [Tip Estimation] in the 

context menu. Next, input the tip region as the numbers of pixels parallel to the x and y-axis from 

“Tip Nx” and “Tip Ny” dialogs, respectively. Finally, input the tolerance of the tip size from 

“Parameter” dialog. The range of the tolerance is from 0.0 to 1.0. Since we cannot choose one 

Image View 
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result from infinite candidates of the estimated tip shape only in our tip estimation algorithm, we 

use the value of this parameter to obtain the result. When we set the value 0.0 (1.0), the largest 

(smallest) size of tip is selected. Data of this estimated tip shape is automatically saved as the file 

‘tip_result.cube’ in the same directory as the measured data. Moreover, the image of the shape is 

displayed on a new “Image View” window. 

 

Removal of the effect of the tip shape 
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1. Right click on “Image View” window  Context menu is displayed  Select [Eliminate Tip 

Effect] 

2. Input a file name of the tip data from “Select Tip” dialog  Push [OK] 

 

After loading a measured data on the “Image View” window, we select the [Tip Estimation] in the 

context menu. Next, we select a tip data. Then, the data obtained by removing the influence of the 

tip from the measured data is automatically saved as the file ‘image_eliminated_tip_effect.cube’ in 

the same directory as the measured data. Moreover, the image of the data is displayed on a new 

“Image View” window.  

 

 

8  Visualization setting 

 

 

How to change among various visualization modes 

 

【Change between 2D and 3D view】 

 

We explain how to change from the 2D-view to the 3D-view. The operation from ‘3D’ to ‘2D’ is in 

the same way. 

 

8  Visualization setting 
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1. Right click on “Image View”  Context menu is displayed  Select [3D-View] 

 

 

【Display the cross section】 
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1a. To set the starting point , double click on “Image View” 

1b. To set the end point, double click on “Image View” 

2a. Right click on “Image View”  Context menu is displayed  Select [3D-View] 

2b. Right click on “Image View”  Context menu is displayed  [Cross-Section]  [Clipping] 

 

 

We can set starting and end points only when the “Image View” is in the 2D-view mode. After we 

set the end point, the “Cross Section View” is automatically displayed and the graph of the cross 

section is shown. When we change the view mode to the ‘3D’ and choose the [Clipping] menu on 

the “Context menu”, we can see the cross section on the 3D-view mode. If we want to see the 

ordinary 3D image, we choose the [Clipping] menu again. When we choose the [Clear] menu, the 

position data of the starting and end points is cleared. 

 

【Reversal of the color bar direction】 
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1.  Right click on “Image View”  Context menu is displayed  Push [z-range Reverse]53 

 

【Normalization of the z-coordinate value】 

 

 

1.  Right click on “Image View”  Context Menu is displayed  [z-range Normalize]54 

 

                                                             
53 The [z-range Reverse] button is a toggle one. By repeating the click, we can switch the direction 

of the color bar. 
54 The [z-range Normalize] button is a toggle one. By repeating the click, we can switch the 
normalization/denormalization. 
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When the difference in height is too small compared to the sizes of the width and depth, the 

visualization on the 3D-view is like a plane. In this situation, we can display the data with an 

emphasis of the difference in height by normalizing the values of the z-component.  

 

【Set color for visualization】 

 

1.  Right click on “Image View”  Context menu is displayed 

2.  Select [Color]  [Monocrome / Gradation / Rainbow] 

 

 

【Lighting】 

Rainbow 

Monocrome 

Gradation 
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1.  Right click on “Image View”  Context menu is displayed  Select [Lighting]55 

 

We can do this operation only when the view mode is the 3D-view. 

 

【Isoline】 

                                                             
55 The [Lighting] button is a toggle one. By repeating the click, we can switch the presence/absence 
of the lighting. 
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1.  Right click on “Image View”  Context menu is displayed  Select [Isoline]56 

 

【Surface display type】 

                                                             
56 The [Isoline] button is a toggle one. By repeating the click, we can switch the presence/absence 
of the isoline. 
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1.   Right click on “Image View”  Context menu is displayed 

2.   Select [Display-Type]  [Fill / Wire Frame] 

 

We can do this operation only when the view mode is the 3D-view. 

 

Change viewpoint, zoom all, scaling, and perspective 

 

There are several operations available only when the view mode is the 3D-view. 

  

【change a viewpoint】 

Fill 

Wire Frame 
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1.  Right click on “Image View”  Context menu is displayed 

2.  Select [Top/Front/Side] 

 

We can change a viewpoint from Top, Front, and Side, by this operation. By dragging the mouse on 

the “Image View” we can change the view angle freely. In order to shift a viewpoint in parallel, we 

drag the mouse while holding down the [Shift] key. 

 

【Zoom All】 

Front 

Top 

Side 
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1.  Right click on “Image View”  Context menu is displayed  Select [Zoom All] 

 

After selecting the [Zoom all] button, scaling and translation are automatically done and all the 

components are displayed so as to fit to the “Image View” window.  

 

【Scaling】 

1. The mouse wheel  rotate 

Scaling can be carried out to an arbitrary magnification by rotating the mouse wheel. 

 

【Perspective】 
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1. Right click on “Image View”  Context menu is displayed  Select [Perspective]57 

 

  

                                                             
57 The [Perspective] button is a toggle one. By repeating the click, we can switch the perspective 

view on and off. 
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9  Digital image processing functions 

 

The Analyzer-module provides four functions as the digital image processing tool; 

 Binary image generation using a threshold 

 Contrast adjustment (gamma correction) 

 Edge extraction (Sobel filter processing) 

 Noise reduction (median filter processing) 

Note that we cannot use any two functions of them at the same time for one image data. For 

example, after the edge extraction for one “cube” formatted file, we cannot immediately apply the 

contrast adjustment to the result data. When you intend to apply such two or more processing for 

one “cube” file, save the result data as another “cube” file after any step of the processing, and 

then reopen the new “cube” file to apply the next step of the processing. 

 

The reason why any two functions of the digital image processing cannot be applied to one image 

data at the same time is as follows. Typically, the result data may different due to the order of the 

processing functions applied to the starting image data. To be briefly, a function A after a function B 

is different from a function B after a function A. Therefore, you should be careful about the order of 

the processing, and should write down the parameters used at each processing. 

 

Binary image generation using a threshold 

 

We can obtain the binary image (black-and-white 

image) data from a “cube” formatted image data 

as follows. 

 

Right-click on the image window to open the 

context menu. After selecting [Black and while] 

from the menu, you see a [Threshold] window.  

 

 

 

9  Digital image processing functions 
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Input the threshold for the binary image generation, from 

0.0 to 1.0. The default value is 0.5. Click [OK] to generate 

the binary image. 

 

 

The “cube” image data has (x, y, z) values, where z value 

stands for heights. Set the highest z value as 1.0, the 

lowest z value as 0.0, and the averaged value of z as 0.5. 

We convert z values into the range [0.0, 1.0] according to 

the kinked line shown in the right figure. In an image, we 

repaint white beyond the threshold, and black otherwise. 

That is the origin of the word “binary”.  

 

Here is the example. This is the original image 

data before the binary image generation. 

(Provided by Prof. Hirayama at Tokyo Institute of 

Technology, Department of Materials & 

Engineering.) 

 

 

 

hmin hmax have 

0.0 

0.5 

1.0 

Height 

Threshold 
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This is the result of the binary image 

generation with a threshold 4.0.  

This is the result of the binary image 

generation with a threshold 6.0.  

 

 

Contrast adjustment (gamma correction)  

 

We can utilize the contrast adjustment for a “cube” formatted image data as follows. Right-click on 

the image window to open the context menu. After selecting [Contrast adjustment (Gamma 

correction)] from the menu, you see a [Gamma] window. 

Input the contrast adjustment parameter  from 0.25 to 4.0, 

where the default value is 1.0. Click [OK] to generate the result 

image. 
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Here is the example. This is the original image 

data before the contrast adjustment, where 

the brightness is wholly too high to distinguish 

the difference in height. 

This is the result of the contrast adjustment 

with  = 0.33. The image has been improved to 

see the small difference in height of the object. 

(The original image data is provided by Prof. Fukui at Surface/Interface Chemistry Group in 

Department of Materials Engineering Science, Osaka University.) 

 

Edge extraction (Sobel filter processing) 

 

We can utilize the edge extraction for a “cube” formatted image data as follows. Right-click on the 

image window to open the context menu. After selecting [Edge detection (Sobel filter)] from the 

menu, you see the result data. 

Here is the example. This is the original image 

data before the edge extraction. (Provided by 

Prof. Hirayama at Tokyo Institute of Technology, 

Department of Materials & Engineering.) 
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This is the result of the edge extraction. As you 

see, the brightness is wholly dark, so the 

contrast adjustment is suitable to improve this 

image. Save this image data as a new “cube” 

file, and then close the data. 

Open the “cube” file saved a moment ago, and 

then apply the contrast adjustment with  = 

2.0. You see the edges more clearly. 

 

 

Noise reduction (median filter processing) 

 

We can utilize the noise reduction for a “cube” formatted image data as follows. Right-click on the 

image window to open the context menu. After selecting [Noise reduction (median filter)] from the 

menu, you see the result data. 
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Here is the example. This is the original image 

data before the noise reduction, where you see 

small noises.  

This is the result of the noise reduction. You 

find the noises in the original image have been 

removed. 

(The original image data is provided by Assistant Prof. Hashimoto at Solid-State Quantum Transport 

Group, Quantum Condensed Matter Physics, Department of Physics, Tohoku University.) 

 

10  Measurement of angle among three points 

 

We can measure an angle among any three points A, B and C on the “Image View”. We obtain not 

only the angle ∠ABC but also the length AB and BC. 

 
 

(1) Here is the example. We intend to measure the (2) At first, zoom in the image to magnify 

10 Mesurement of angle among three points 
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angle and the lengths of the rhomboidal lattice 

surrounded by a green border. (Provided by Prof. 

Hirayama at Tokyo Institute of Technology, 

Department of Materials & Engineering.) 

the target area. Use the mouse wheel to 

zoom in the image, and the mouse drag to 

move the image in parallel. 

 

 

(3) Next, right-click on the image window to open 

the context menu. After selecting [Measurement of 

lines and their angle] from the menu, double click 

on the image successively  three times to specify 

three points A, B and C. 

(4) After that, a window appears and tells 

us the angle ∠ABC and the length AB and 

BC. 

 

 

 

11  Others 

 

 

Display the value of data 

 

11  Others 
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1.  Right click on “Image View”  Context menu is displayed  Select [Show Data]  

 

We can see the tabulated numerical data on the “Data View”. 

 

Adjustment of tilt 

 

 

 

1.  Right click on “Image View”  Context menu is displayed  Select [Correct tilt]  

 

Align / close Image View 

 

【Tile-type alignment】 
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1.  Select “Menu Bar”  [Window]  [Tile] 

 

【Cascade-type alignment】 

 

 

1.  Select “Menu Bar”  [Window]  [Cascade] 

 

【Close Image View(s)】 
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1.  Select “Menu Bar”  [Window]  [Close All] 

 

All the Image View windows are closed by this operation. 



 172 

 

Chapter 5 

Sample Modeling 
 

 

 

In this chapter, we introduce how to use supporting tools for SPM Simulator by which we make a 

model of a sample structure. There are two types of tools at present; 1) modeling of thin films and 

2) modeling of molecules. Since each tool has a Graphical User Interface (GUI), we can model a 

sample structure visually. 

 

 

1  Modeling of thin films 

 

 

Introduction 

 

In the SPM Simulator, the Modeling Tool is included. We can make a model of a thin film with an 

idealized surface by using the tool. The output format of the tool is suitable for the input format of 

the SPM Simulator. Although the target of the tool is mainly atomic scale structures, the structure 

data made by the tool may be used on the simulators for the macroscopic measurements. In the 

tool, we can add, move, and delete an arbitrary atom on the model structure. Moreover, the tool 

has functions to import a molecular model to another structure model and to make the carbon 

nanotube/fullerene structure model. In this section, we describe how to use the Modeling Tool. 

 

 

 

 

 

 

 

 

 

 

1  Modeling of thin films 
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Modeling Tool GUI 

 

 

 

We describe the main function on the Modeling Tool GUI. 

【Menu Bar】 

Start to make a new model, operate a file such as load and save, and display/hide on the 

sub-windows. 

 

【Structure Controller】 

Menu Bar 

Tool Bar 

Structure Controller 

Main View 

Log View 

“Structure” Tab “Make CNT” Tab “New Slab” Tab 
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Make/edit a model. This editor is composed of the four tab view: the “Welcome” tab displays 

the initial message. On the “New Slab” tab, we make a model of a thin film. On the “Structure” 

tab, the coordinate data of atoms is displayed, and also we can edit the information of atoms. 

On the “Make CNT” tab, we make a model of the carbon nanotube and its derivatives. 

 

【Main View】 

Visualize the model on 3D. We can change our point of view by operating the mouse and 

keyboard. Also, we can select and move a cluster of atoms in the model. 

 

【Log View】 

Display messages from the GUI. 

 

 

Start the Modeling Tool 

 

After the SPM Simulator is installed properly, the shortcuts to the Modeling Tool are generated on 

your desktop and in your start-menu. Double-click the shortcut so that the GUI of the Tool starts 

up58. 

 

 

How to operate the GUI 

 

We can operate the equipped functions by using the mouse on the “Main View”, such as the 

change of the point of view, selecting of an atom we want to edit, and moving and rotating the 

selected atom. In this subsection we introduce such kind of mouse operations on the “Main View”. 

 

【Setup before the operation】 

At first, open any model by the Modeling Tool. One of the easiest ways is to click the “Make CNT” 

button at “Make CNT” tab. A carbon nanotube model is then created and displayed on the “Main 

View”. 

 

【Operation modes】 

There are five operation modes on “Main View”; such as “View Mode”, “Edit Mode”, “Link Mode”, 

“Distance Mode” and “Angle Mode”. Now we use “View Mode”, mainly applied to change the point 

                                                             
58 The entity of the Modeling Tool is mkatmstruct.exe in the installed directory, which is at 
"C:/Program Files/SPMSimulator" by default. 
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of view. The other modes are introduced later. Click the corresponding icon on the toolbar to 

change your operation mode. They are exclusive toggle button so that only one of them can be 

toggled. 

 

The keyboard shortcut [Ctrl+E] also changes those five modes in a sequential order. 

 

【Type of visualization】 

We can change the types of visualization of the structure from “Auto”, “Dot”, “Ball”, “Ball&Stick”, 

and “Cartoon” in the “View Option” on the context menu. When we choose the “Auto”, the Tool 

automatically determine the suitable type for the structure data. We comment that there are cases 

in which the structure is not displayed. When we want to display the structure by the “Ball&Stick” 

type, the data of the structure needs to have the information of the bonds between atoms. When 

displaying the structure by the “Cartoon”, the format of the data needs to be a special PDB one. 

 

 

“Dot” 

 

“Ball” 

 

“Ball&Stick” 

 

“Cartoon” 

 

【Change of the point of view】 

We can change the point of view by choosing from “Top”, “Front”, and “Side” in the context 

menu. When we want to change the visualization to the perspective one, we are supposed to check 

the “Perspective” in the context menu. We can change the scaling of the visualization by rotating 

the mouse wheel. 

In the “View Mode”, we can also change the visualization by operating the mouse as follows on 

the “Main View. 

 

View Mode 

Link Mode 

Edit Mode 

View Mode Angle Mode 

Distance Mode 
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Rotate the point of view 

 

Translate the point of view 

 
Scaling 

 

 

Moreover, we can change the visualization by operating the keyboard, too. 

Key Operation Action  

 [↑, ↓, ←, →] Translate the point 

of view 

 

[Shift]＋[↑, ↓] 

[Shift]＋[←, →] 

[Shift]＋[PageUp, PageDown] 

Rotate the point of 

view as the right 

figure 

 

[Ctrl]＋[↑, ↓] 

[PageUp], [PageDown] 

Scaling  

 

【Zoom All】 

A hand glass icon on the tool bar is used to resize and translate the model in order to store the 

model in the whole screen.  

drag 

Key + drag Shif

t 

Key + drag Ctrl 

Rotate the wheel  
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This function is effective only when the drawn model consists of two or more atoms and 

“Perspective” is switched off. 

 

【Compass】 

There is a three-dimensional compass on the bottom right corner, which shows the x-, y- and 

z-direction for your eyeshot. 

 

 
Click “Show Compass” on the context menu repeatedly, to show or to hide the compass. 

 

【Show supercell】 

The model range is shown as a parallelepiped by toggling the parallelepiped icon on the toolbar. 

Zoom All 

Show compass 

Not show compass 

On 

Off 
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Click it again to hide the frame. 

 

When you made up a model from the “New Slab” tab with lattice information, you may see a 

parallelepiped supercell. On the other hand, when you load a model file without the lattice vectors, 

you may see a rectangular solid which just fit the model range. 

 

 

 

Make a thin film 

 

In order to model a thin film, we need to obtain the 

information about the crystal lattice, such as the space 

group, the lattice parameter, the fractional atomic 

positions, the Miller index, and the number of cells. 

These data are basically obtained from academic 

magazines. 

 

【How to model a Si (001) surface】 

We explain how to make a new model of a thin film 

that imitates a Si (001) surface. When we make a model 

from scratch, we open the “New Slab” tab by clicking 

the “a new slab” button on the “Welcome” tab. We can 

also open the “New Slab” tab by clicking the tab 

Not show supercell Show supercell 

Without lattice information With lattice information 
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heading directly. We input the information of the crystal lattice on the tab. We can input an 

arbitrary string on the “Title” form. When we omit the input, the name of the space group that will 

be set below is automatically inputted. We recommend using the 1-byte alphanumeric characters 

to input to all the forms.  

We set the information of the space group in the second form. When we click the “Spg. No.” 

button, the “Space group” window is emerged and the list of the space group is displayed on the 

window. We can choose a suitable number of the space group for the thin film. We can also input 

the number directly without using the list. Select or input 227 for the fcc silicon, then click OK.  

The forms in the third column are for the lattice constants. Although we can input to them 

directly, the number of the forms we can input is restricted by the space group number. The units of 

the length and the angle are Å and degree, respectively. In the case of the fcc silicon, the values for 

all the forms are 5.4, 5.4, 5.4, 90.0, 90.0, and 90.0. However, we are sufficient to input the first ‘5.4’ 

for the reason stated above. 

In the next column, we input the type and the fractional coordinates of atoms in the Bravais 

lattice. In order to input the atomic element, push “Spec” button to open “Periodic Table” dialog. 

 

You see a periodic table. When you push a “Si” button, then the dialog is closed and the atomic 

symbol “Si” is input in the form. As for the fractional coordinates, we input their values to the forms 

of the “x/a”, “y/b”, and “z/c”, respectively, and push “Add” button. We need to repeat this 

procedure as many as the number of atoms. In case of the fcc silicon, there is a single fractional 

coordinate, say 0.0, 0.0, 0.0. We can modify and delete the data for an atom by using the “Modify” 

and “Delete” buttons, respectively. Also, we can clear all the data of the list by clicking the “Clear all” 

button. 

In the last column, we input the information for a surface and a thin film, which is the direction 

of the surface, the size of the film, and the hydrogenation of the boundary. We input the direction 

by the “Miller index”. The size of the film can be assigned from the “Number of cells” forms, which 

generates a supercell with the inputted numbers in each direction of the unit cell. We here specify 0, 
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0, 1 at “Miller index” to make Si(001) surface, and 3, 3, 1 at the “Number of cells”. 

If all the inputted data are valid to make the model, the structure of the thin film is displayed on 

the “Main View” after pushing the “Make Surface” button. The value of the translational vectors is 

displayed on the “Log View”. As for the meaning of the value, please read the “Notification to use 

on SPM Simulator” subsection. 

When the structure is displayed, we can edit the data of each atom in the structure from the 

“Structure” tab. The way to edit is described on the following subsection “Edit of model data”. As 

for the way to save the data of the generated model, see the following subsection “Saving the 

model structure”. 

 

 

 

 

【How to model a Si (111) surface】 

How to make a new Si (111) surface is almost the same as the previous work. Note that “Title” is 

now “Si111” and “Miller index” is now “1, 1, 1”. Push “Make Surface” button to make and display 

the new model. The value of the translational vectors is displayed on the “Log View”. 

 

If all the inputted data are valid to make the model, the structure of the thin film is displayed on 

the “Main View” after pushing the “Make Surface” button. The value of the translational vectors is 

displayed on the “Log View”. As for the meaning of the value, please read the “Notification to use 

on SPM Simulator” subsection. 

 

【How to model a graphite (0001) surface】 
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The information of the graphite crystal is as follows. 

 

Lattice constant 2.464  2.464  6.711  90.0  90.0  120.0 

Space group 194 (P 63/m m c) 

Fractional atom 

coordinate 

C1  0.00000  0.00000  0.25000 

C2  0.33333  0.66667  0.25000 

 

Although the precise value of the fractional coordinate of one carbon is (1/3, 2/3, 0.25), we 

cannot input the value of the numerator/denominator-style. In such a situation, we need to input 

the number with the 5 significant figures as above. 

In the case of hexagonal and rhombohedral structures, it is possible to use the Miller index which 

has 4 numbers (h k i l). Though the four numbers are not independent each other. In the Modeling 

Tool, we are supposed to input three numbers: (h k l). 

 

 

Save the model structure 

 

【Save as a data file】 

We can save the displayed structure model as the structure data. First, we select the “Save as” in 

the “File” menu on the menu bar. Next, we choose one from the “in XYZ format” (format for the 

Quantum Mechanical Simulator), “in Tinker format” (format for the Classical AFM Simulator), and 

“in Modeling Project”. When the saving file dialog is opened, please input the file name and save 

it. When we save the data as “in Modeling Project”, we need to input the data on the “New Slab” 

tab properly. 
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Before saving the model data as “in Tinker format”, we have to assign the type of atoms (see page 

188) that is necessary to simulate by CG/MD solvers in the SPM simulator. 

 

【Save as a picture file】 

 We can save the visualization displayed on “Main View” as a picture file. When we select the 

“Export Image” in the “File” menu on the menu bar, the “Save Capture” dialog is displayed. We can 

input an arbitrary file name and select the format of the picture file from PNG (*.png), Bitmap 

(*.bmp), and JPEG (*.jpg). 

We can also save as a picture file by right-clicking on the “Main View” and selecting the “Export 

Image” on the context menu. 

 

 

Load of a model data 

 

We can load the existing data and display the model on the GUI. By selecting the “Open” in the 

“File” menu on the menu bar, the “Open File” dialog opens. 
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The formats that the Tool can load are xyz (*.xyz), tinker (*.txyz), PDB (*.pdb), Modeling project 

(*.mpro), CIF (*.cif) and VASP (*.vasp). Select a file you like from the dialog.  

You can also load a prepared file by drag and drop the file icon. 

 

After loading a xyz-, txyz, or pdb-file, the data of the structure is displayed on the “Structure” tab 

and visualized on the “Main View”. The interatomic bonds are taken into account contained in txyz- 

and pdb-file. 

 

On the other hand, after loading a mpro-, cif- or vasp-file, the information of the crystal structure 

is input automatically on “New Slab” tab, so that you may avoid the boring manual input (see page 

178). 
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A CIF file may have two or more crystal information. When you open such kind of CIF files, the 

dialog shown below asks you which data block you would like to use. 

 

 

We can load the data from the files used recently. We select the “Recent Files” in the “File” menu 

on the menu bar and choose a file we want to load from the list. The number of files in this list is at 
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most 10. 

 

 

Import of model data 

 

We can add an existing data to the data of the displayed model. On the condition that a data is 

already loaded as a base model on the Tool, we select the “Import” in the “File” menu on the menu 

bar and choose the file of which we want to add the data. 

The added model is set above the base model so as not to overlap each other. The formats of the 

data that can be imported properly are xyz (*.xyz) and tinker (*.txyz). 

You can also import a prepared file by drag and drop the file icon while still pressing the [Ctrl] 

key. 

 

 

Quit of the Modeling Tool 

 

To quit the Modeling Tool, select the “Quit” in the “File” menu on the menu bar, or click [X] 

button at the upper-right corner.  

 

At that time, if your model data has been edited and not saved yet, the dialog shown below asks 

you to save the model or not. 

 

Click [Save] button to open the save dialog, then the Tool quits after saving your model data. Click 

[Discard] button to quit anyway without saving your model. [Cancel] button does nothing but 
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continues the Tool. 

You can also quit the Tool without saving your model by the quit-operation while still pressing the 

[Shift] key. 

 

 

Edit of model data 

   

When we use the “Structure” tab, we can add, edit, 

and remove an atom in the model data. 

 

【Add an atom】 

When we want to add an atom, we use the “Duplex” 

button. First, we select the column of the atom whose 

position we consider to the origin from the list in the 

“Structure” tab59. Next, we input the coordinates of the 

atom we want to add in relative value from the origin. 

Finally, we push the “Duplex” button. The added atom is 

displayed on the “Main View”. Although the same atom 

as the selected one is added, we can change the atom 

type by using the “Spec” button. 

 

【Edit an atom】 

When we want to edit an atom, we use the “Change” button. First, we select the column of the 

atom we want to edit from the list. When we input the value of the relative coordinate and push 

the “Change” button, the value of the coordinate of the selected atom changes. If another atom 

already exists on the destination, we cannot change the value of the coordinate. When we want to 

change the type of the selected atom, we push the “Spec” button, choose the type, and click the 

“Change” button. 

 

【Delete an atom】 

When we want to delete an atom, we use the “Delete” button. After we select the column of the 

atom we want to delete from the list, we push the “Delete” button. Instead of the “Delete” button, 

                                                             
59 In order to select the multiple columns, we can use the clicking with the Ctrl-key. In order to 
select the region of the columns, we can use the clicking with the Shift-key. When we push the ‘A’ 
with the Ctrl-key, we can select all the columns. As we explain in the following subsection, we can 
select on the “Main View” graphically. 
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we can use the Delete-key on the keyboard. 

 

【Selection of an atom to edit】 

We can select an atom to edit its data by using the mouse in addition to use the “Structure” tab. 

The way to operate is in the following tables, which is separated in the “View Mode” and the “Edit 

Mode”.  

 

View Mode 

Double click the blank region Unselect all the atoms 

Double click an atom object Select/Unselect (toggled) 

 

Edit Mode 

Double click the blank region Unselect all the atoms 

Click an atom object Select/Unselect (toggled) 

Drag from an point on blank region Add the atoms in the specified 

region as the selected ones 

Drag with Shift-key from an point on blank 

region 

Unselect the atoms in the 

specified region 

Drag with Ctrl-key from an point on blank region Change the status of either 

Select or Unselect for the atoms 

in the specified region 

 

By selecting atoms as the above mouse-operations, the corresponding columns in the “Structure” 

tab are also selected. In this situation, we can edit their information by the operations stated in the 

previous subsections. 
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【Movement and rotation of atoms】 

When the atoms are selected in the “Edit Mode”, we can move and rotate them by the mouse 

operations. The values of the atom coordinates in the “Structure” tab are modified in conjunction. 

 

In “Edit Mode” and when there are the selected atoms 

Drag the selected atoms Translate the atoms 

Drag the selected atoms with Shift-key Rotate the atoms 

 

 

Edit of inter-atomic bond information 

 

In addition to the operation stated in the previous subsection, by using the “Structure” tab, we 

can calculate bond information, add hydrogen atoms, and assign the type of atoms. 

 

【Calculation of bond information】 

When we push the “Bond” button, the information of the bonds between atoms is calculated 

and updated. When we choose the “Ball&Stick” on the “View Option” menu, we can see the 

visualization of the bonds. When there are a lot of atoms in the model, it takes too long to 

calculate.  

 

【Delete bond information】 
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When we push the “Bond delete” button, the information of the bonds between atoms is 

deleted. When we edit the structure data with the information, it occasionally takes too long to 

process the data. When we encounter such a situation, we recommend deleting the bond 

information temporally. After we finish editing the data, we may update the bond information. 

 

【Add hydrogen atoms】 

When we push the “Hydrogenate” button, the hydrogen atoms are added to the atoms that have 

the inadequate number of the bonds, and the number of the bonds to the atoms becomes suitable 

one. 

 

【Assignment of the type of atoms】 

When we push the “Bond/MM3” button, the Tool automatically assign the type of all the atoms 

in the structure. The information of the type is needed when we use the structure data on the 

Classical AFM Simulator. We suppose to use this function like a following flow: (1) load the 

xyz-format file on the Tool, (2) assign the type of atoms, (3) save the data as Tinker-format file, and 

(4) use the file on the Classical AFM Simulator. 

 

 

Link Mode 

In “Link Mode”, we can create or destroy atomic bonds between any atoms. Click the “Link Mode” 

icon  to switch to “Link Mode”. 

In order to create a bond between atoms A and B, click the atoms successively on the “Main 

View”. Clicking atoms sequentially, we can create a sequence of bonds. 
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Click the blank region on the “Main View” to unselect all the atoms and to cancel the link 

operation. 

 

On the contrary, in order to destroy a bond between atoms A and B, click the atoms successively 

on the “Main View” while pressing the [Shift] key. Clicking atoms sequentially while pressing the 

[Shift] key, we can destroy a sequence of bonds. 

 

As in “View Mode”, we can change the point of view (rotate, translate and scaling) by operating 

the mouse.  

 

Distance Mode 

In “Distance Mode”, we can measure a bond length between any atoms. Click the “Distance 

Mode” icon  to switch to “Distance Mode”. 

In order to measure a bond length between atoms A and B, click the atoms successively on the 

“Main View”. Then you see a dashed line between them, and the distance is shown on the “Log 

View”. 

 

Shift key pressed Shift key pressed 

A 

B 

Distance Mode 
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Click the blank region on the “Main View” to unselect all the atoms and to cancel the 

measurement.  

As in “View Mode”, we can change the point of view (rotate, translate and scaling) by operating 

the mouse.  

 

 

Angle Mode 

In “Angle Mode”, we can measure an angle among any three atoms. Click the “Angle Mode” icon 

 to switch to “Angle Mode”. 

In order to measure an angle ∠ABC among three atoms A, B and C, click the atoms successively 

on the “Main View”. Then you see a kinked line and an arc among them, and the angle is shown on 

the “Log View”. 

 

Click the blank region on the “Main View” to unselect all the atoms and to cancel the 

measurement.  

As in “View Mode”, we can change the point of view (rotate, translate and scaling) by operating 

the mouse. 

 

 

A 

B C 

Angle Mode 
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Undo and redo the operation 

You can undo or redo the various operations on the Modeling Tool. Undo command restores the 

information about the model before an editing work (the number of atoms, atomic species, 

coordinates, bonds, editing status). You can undo/redo using [Edit] menu on the menu bar, or using 

the corresponding keyboard shortcuts: 

Function By menu By keyboard 

undo Menu bar[Edit][undo] Ctrl+Z 

redo Menu bar[Edit][redo] Ctrl+Y 

As soon as undo is executed, the redo command also becomes active. 

 

The list of editing works which are able to be undone or redone is shown below. 

1 Import a model. 

2 Add atoms. 

3 Delete atoms. 

4 Change atoms. 

5 Make bonds. 

6 Clear bonds. 

7 [Hydrogenate] operation. 

8 [Bond/MM3] operation. 

9 Translate or rotate atoms by the mouse during the edit mode.  

10 Make a new model by [Make Surface] button on “New Slab” tab. 

11 Make a new model by [Make CNT] button on “Make CNT” tab. 

12 Load a prepared model while destroying the displayed model, by the use of 

[File][Open] or drag&drop. 

13 Import a prepared model to the displayed model, by the use of [File][Import] or 

Ctrl+drag&drop. 

14 Load a [Recent Files]. 

The Undo command can be repeated up to 30 times. 

 

The undo/redo history is cleared when the following commands are executed.  

1 Run the Modeling Tool. 

2 [File][New]. Discard the present model, and reset all settings. 

3 Quit the Modeling Tool. 

 

The so-called clean index is set when the following commands are executed. 



 193 

1 [File][New]. Discard the present model, and reset all settings. 

2 [File][Recent Files].  

3 [File][Save as][in XYZ Format].  

4 [File][Save as][ in Tinker Format].  

5 [Make Surface] button on [New Slab] tab to make a new surface model. 

6 [Make CNT] button on [Make CNT] tab to make a new carbon nanotube model. 

In all case, the clean index is set when a prepared file is loaded or when a model is saved to a 

file. 

When you edit a displayed model, then the file name on the title bar will be attached by [*], 

which means the present model is not saved yet. If you intend to quit the GUI with [*] on the title 

bar, a message dialog appears and asks you to save the model. 

On the other hand, once the clean index is set by e.g. saving the model data, the [*] of the file 

name on the title bar disappears. Now you can quit the GUI without any dialog. 

 

 

Tool bar 

The toolbar is located at the head of the GUI. The various functions equipped with the GUI are 

available by the use of the buttons on the toolbar. The available functions are as follows:  

 

 Function Alternate command 

① 
Discard the present model, and reset all settings. [File][New] 

② 
Discard the present model, and load an existing model. [File][Open] 

③ 
Save the present model as *.xyz, *.txyz or *.mpro format.  [File][Save as] 

④ 
Save the visualization displayed on “Main View” as a picture 

file. 

[File][Export Image] 

⑤ 
Undo. [Edit][undo] 

⑥ 
Redo. [Edit][redo] 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 
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⑦ 
Switch to “View Mode”. It is a toggle button.  [Ctrl+E] 

⑧ 
Switch to “Edit Mode”. It is a toggle button. [Ctrl+E] 

⑨ 
Switch to “Link Mode”. It is a toggle button. [Ctrl+E] 

⑩ 
Switch to “Distance Mode”. It is a toggle button. [Ctrl+E] 

⑪ Switch to “Angle Mode”. It is a toggle button. [Ctrl+E] 

⑫ Resize and translate the model in order to store the model in 

the whole screen.  

 

⑬ Show or hide the compass. It is a toggle button.  Context menu  

 [Show Compass] 

⑭ Change the view option. Context menu  

 [View Option] 

⑮ Show or hide a supercell. It is a toggle button.  

 

 

Make carbon nanotube data 

 

In this Tool, we can make carbon nanotubes (CNT) and their derivatives. 

 

【Procedure】 

1. Open the “Make CNT” tab. 

2. Set the value of parameters. 

3. Push the “Make CNT” button. 

4. The result is displayed on the “Structure” tab and the “Main View”. 

 

1 

3 

4 2 
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【The meaning of parameters】 

<mode>: type of CNT: 

We can choose one of the four types of CNT listed below: 

1. swcnt: Single wall CNT 

2. sheet: graphene sheet 

3. fuller: fullerene 

4. capped: CNT with caps 

 

<Chx>, <Chy>: x, y-component of chiral vector: 

The chiral indices of CNT: (n,m) = (<Chx>, <Chy>) 

The size and the helix angle are dependent on the values of the parameters. 

The values are integer and 0≤|m|≤n. 

When we choose the mode of “sheet”, “fuller”, and “capped”, the available values of both 

n and m are the multiple of 5. 

 

<Ncell>: The number of unit cells in CNT 

The length of the unit cell is naturally determined by the value of the chiral indices. The 

length of the generated model CNT is <Ncell> times of the length of the unit cell. 

 

[output file]: output file name 

File name of output data, which cannot be edit. 

 

【Example】 

<mode>  = swcnt 

<Chx>   = 10 

<Chy>   = 5 

<Ncell> = 2 

<mode>  = sheet 

<Chx>   = 20 

<Chy>   = 20 

<Ncell> = 1 

<mode>  = fuller 

<Chx>   = 5 

<Chy>   = 5 

<Ncell> = 1 

<mode>  = capped 

<Chx>   = 5 

<Chy>   = 5 

<Ncell> = 5 

    

 

 



 196 

Make graphene data 

 

We can make single layered graphene sheets. 

 

【Procedure】 

1. Open the “Make CNT” tab. 

2. Input the options to make a graphene sheet. 

3. Push the “Make Graphene” button. 

The result is displayed on the “Structure” tab and the “Main View”. 

 

 

 

【options】 

C-C nearest distance [ang]: 

The nearest neighbor distance between carbon atoms, which is fixed at 1.412 Å by 

default. 

 

x-length of graphene [ang]: 

Transversal length of graphene sheet. The default value is 20 Å. 

 

y-length of graphene [ang]: 

Longitudinal length of graphene sheet. The default value is 20 Å. 

 

We can make a graphene sheet with any size specified in those options.  

1 

3 4 2 
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After that, if necessary, do [Hydrogenate] to add hydrogen atoms, do [Bond/MM3] to assign the 

type of atoms and save your model. 

 

 

Notification to use on SPM Simulator 

 

We can use the structure file generated by the Modeling Tool on the Classical AFM Simulator and 

the Quantum Mechanical SPM Simulator. However, it is necessary to note the following points on 

use. 

 It is possible to generate a structure file in which atoms are placed too closely. We cannot 

obtain the proper results by the simulations with such a file. When we select a spherical object 

on the “Main View” and the entire of the object is not highlighted with yellow, the object can 

consist of multiple atom objects, that is, the tool can generate atoms placed too closely. In this 

case, we recommend you to check again the value of the input parameters, especially, of the 

fractional atom coordinate. 

 The translation vectors dumped to the “Log View” are calculated from the crystal data and 

their value is not for slab calculations. When we use a structure data on the SPM Simulator, we 

supposed that you set the length of the so-called ‘c’-vector to be too large (e.g, (0.0 Å, 0.0 Å, 

100.0 Å)).  

 In the files of the Tinker-format, information of the atom types, which describes the states of 

the atom, is contained. For example, the carbon atom has different states such as sp3, sp2, and 

so on. The Modeling Tool automatically assigns only for the atom types of Si, C, and H. When 

you cannot simulate with the files of the Tinker-format, you need to edit the files without 

using the Tool. 

 When you want to a model for tip structure, you can easily generate it by using the corner of 

the crystal model. You can generate a stable structure by terminating the entire surface with 

hydrogen. We supposed to delete a hydrogen atom on the tip apex if necessary. 

20 x 20 Å 12 x 30 Å 50 x 18 Å 
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 Notification to load a CIF file. 

As you probably know, a CIF has occupancy of an atomic site. The occupancy may have a 

fractional value (0.0 – 1.0) e.g. in case of the presence of a defect. Unfortunately, the 

Modeling Tool does not deal with a fractional occupancy but set it as “1.0”, which means that 

an atom fully exists on the specified site. When loading such a kind of CIF file, the log view 

tells us some warning as below. 

<<< Load a file "C:\sample\sample.cif" >>> 
Now loading ...  
Warning: incomplete occupancy 0.3333 for Ow at 0.736 0.368 0.491 
Completed to load. 

Now the crystal structure on “New Slab” tab is shown like this.  

 

The log view tells us the fractional coordinate of the atomic site that has a fractional 

occupancy. You will see the relevant atom is oxygen as indicated in the figure above. You can 

make a model by [Make Surface] button, but the resulted model is obviously invalid. 

 

There are three oxygen atoms very close to each other. The occupancy 0.3333 implies that 

one of those three oxygen atoms exists within the yellow circle, and is randomly distributed 

when a lot of unit cells are provided.  

The Modeling Tool cannot make an appropriate model if there is a fractional occupancy in 

CIF file. When you see a warning about the occupancy on the log view, notice that the relevant 

model may be questionable. 
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2  Molecular Modeling 

 

 

Introduction 

 

We introduce how to use ChemSketck and OpenBabel. These are the tools for constructing the 

input file of molecular structure. The file made by this method can input to AFM image simulator 

for atoms/molecules/nanostructures. 

In AFM image simulator for atoms/molecules/nanostructures, in order to simulate the AFM image, 

we used MM3 force field parameters developed by Allinger. The following figure shows the 

elements supported by MM3 

.

 

 

MM3 distinguish not only atom elements but also chemical environment.  

 

 

Download ChemSketch 

 

ACD/ChemSketch is free software released by Advanced Chemistry Development Co., Ltd. You have 

to register for downloading and using this tool. In this section, we introduce how to download the 

software. 

 

MM3 element 

2  Molecular Modeling 
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①First, open the web site of URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

②Click the icon at the bottom of the page. 

③Click the “Create an Account”. 

④Fill in the forms of below figure, and Click the “Register”. 

 

 

 

 

 

 

⑤Receive the E-mail and make your account.  

⑥Open the web site of URL: http://www.acdlabs.com/resources/freeware/chemsketch/ 

⑦Click the icon at the bottom of the page. 

 

 

http://www.acdlabs.com/resources/freeware/chemsketch/
http://www.acdlabs.com/resources/freeware/chemsketch/
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⑩Click “Next” button 

 

 

⑪Read the license agreement, select “I accept the terms in the License Agreement”, and click 

the Next button. 
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⑫Click “Next” button 

 



 203 

⑬Click “Next” button 

 

⑭Click “Next” button 
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⑮Click “Install” button 

 

⑯Click “Finish” button 
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⑰Click “ChemSketch”. 

 

 

⑱Click “OK” button 
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⑲Click “Select All” then click “Yes” button. 

 

⑳Click “OK” button 

 

Finished. 

 

 

Download OpenBabel 

 

OpenBabel is free software distributed under the GPL license. This is used to convert the file format 

of chemical information. You have to register for downloading and using this tool. In this section, 

we introduce how to download the software. 
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1 Open the web site of URL:http://openbabel.org/wiki/Main_Page  

2 Click “Download”. 

 

 

3 Click “Download v2.3.2 Installer” under Windows category. 

 

 

4 Click “実行”. 

 

 

5 Click “実行する”. 

http://openbabel.org/wiki/Main_Page
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6 Click “Next” button. 

 

 

7 Read the license agreement and click “I Agree”. 
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8 Click “Next” button. 

 

 

9 Click “Install” button. 
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10 Click “Finish” button. 

 

 

Finished. 

 

Construct the octane by ChemSketch 

 

Now we introduce how to construct chain alkane of octane. (C8H18) 
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1. Start “ChemSketch”. 

2. Make the carbon chain. 

① Select “Structure”. 

② Select C (Carbon) on the left toolbar. 

③ Select “Draw Normal” on the top toolbar. 

 

④ Click in an empty space to draw methane CH4. From here, you can undo and redo by 

keyboard shortcuts Ctrl+Z and Ctrl+Y, respectively.  

 

⑤ Point to CH4 to select it (you will see a rectangle around the methane formula), and then 

click it to add a methyl group to it while creating ethane CH3—CH3.  

 

⑥ Repeat to click the right-most carbon atom until the number of carbon atoms reaches 

eight.  

 

⑦ An octane molecule has been constructed.  

 

3. Click “3D Optimization” button. Then H elements are attached to the carbon chain and 

1 

3 

.  .  . 

2 
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3-dimentional structure is constructed.  

 
4. Output the model. 

① From the File menu, choose “Save As” to open “Save Document As” dialog. 

② In the dialog box, specify the name and location of the file to which the work should be 

placed. In the “Save as type” box, select “MDL Molfiles [V2000] (*.mol)” and click “Save”. 

③ The output file will be converted into *.txyz format by the use of the OpenBabel software 

(see below).  

 

Much more simple way to create an octane molecule is to use “Draw Chains” tool on the top 

toolbar. Hold down SHIFT key and drag right to create a carbon chain and take a look at the carbon 

counter (C #) located beside the mouse arrow. Continue the dragging until the counter reaches C 8, 

then release the mouse button to finish the chain. That’s all. 

 

  

 

Construct the Quinine by ChemSketch 

 

We make a kind of alkaloid, (-)-Quinine (C20H24N2O2) from scratch, whose structure is shown by: 
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1. Start “ChemSketch”. 

2. Make a bone structure. 

① Select “Structure”. 

② Select a benzene ring on the right toolbar.  

 

③ Click in an empty space to draw a benzene ring.  

④ Click a bond on the right side of the benzene to make a naphthalene structure. 

Substitution to a heteroatom is done later. 

 

⑤ Select C (Carbon) on the left toolbar and “Draw Normal” on the top toolbar.  

 

⑥ Make a carbon chain one by one. To extend a new single C-C bond, drag from a starting 

carbon atom to an end carbon position. Substitution to a heteroatom is done later.  

1 

2 

  3   4 

 

 

 5 
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⑦ Make the bone structure on the methoxy group side (-O-CH3) in the same manner.  

 

3. Replacement of atoms, addition of functional groups, modification of bonds. 

① To replace C (carbon) with N (nitrogen) atom, select N on the left toolbar. Click the carbon 

atom site to replace with N.  
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② To replace C (carbon) with O (oxygen) atom, select O on the left toolbar. Click the carbon 

atom site to replace with O.  

 

③ To add a hydroxyl group, select O on the left toolbar. In the same manner as the bone 

structure, we add a hydroxyl group.  

 

④ Make a C=C double bond. Select C on the left toolbar and select “Draw Normal” on the 

top toolbar. Click a C-C bond to change it to a C=C double bond.  

(Click a bond repetitively to switches between available bond types: single, double, or 

triple.) 

⑤ Specify a stereo structure. Select “Up Stereo Bonds” on the top toolbar.  

Click a bond to draw stereo bonds that are facing towards the viewer. 

(Click again to change the wedge direction. “Down Stereo Bonds” next to “Up Stereo 

Bonds” makes a bond facing away from the viewer.) 

⑥ Now we have the structure below:  
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4. 3D Optimization. 

① Click “3D Optimization” button. Then H elements are attached to the carbon chain and 

3-dimentional structure is constructed. 

 

② We will see a dialog, and then click “No” to keep the stereo structure. 

③ Now we have the structure below: 

 

④ Select “3D Rotation” on the top toolbar. Drag on the workspace to rotate the 3D model.  

 

5. Output the model. 

① From the File menu, choose “Save As” to open “Save Document As” dialog. 

② In the dialog box, specify the name and location of the file to which the work should be 

placed. In the “Save as type” box, select “MDL Molfiles [V2000] (*.mol)” and click “Save”. 

③ The output file will be converted into *.txyz format by the use of the OpenBabel software 

(see below).  
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Convert the file format by Open Babel 

 

We have made the MDL mol format file by using “Open Babel”. Now, we introduce how to convert 

to txyz format that is available for the simulator. 

  

1． Start “Open Babel GUI”. 

2． Convert the file format from MDL mol to ttxyz. 

 

1) Select “mol – MDL MOL format” from “INPUT FORMAT” box. 

 

 

2) Select “txyz – Tinker MM2 format” from “OUTPUT FORMAT”. 



 218 

 

 

3) Uncheck “Input below” and enter MDL file made in advance. 

 

 

4) Check “Input below” and enter the name of output file. 

① 

② 
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5) Click “CONVERT” button. 

 

 

6) txyz file will be made. 

 

  

① 

② 

③ 
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Chapter 6 

Trouble Shooting 
 

 

We introduce possible trouble examples and how to fix them when you use the SPM simulator. 

 

 

Troubles on simulation 

 

 

GUI does not start up normally 

If GUI does not start up normally, a version of ig4dev32.dll (which is at C:¥WINDOWS¥system32 

usually) may not suit. Please rename this file to other name (for example, ig4dev32.dll_bak) and 

start up GUI again. If trouble occurs on other application, rename it back please. 

 

 

The modified setting parameters are not reflected in the simulated results 

A user account logging in may not have an authority to write on a folder that has a project file 

loaded at the time. 

The SPM simulator is installed below "C:¥Program Files" by default. The user account who does 

not have administrator rights cannot change or write in that folder. Windows Vista and later have a 

special system named VirtualStore, that makes a new file at an unexpected folder when you 

attempt to make a file below "C:¥Program Files". The SPM simulator does not read the new file but 

the old file below "C:¥Program Files". 

 

There are two ways to solve this problem. The one is to run the SPM simulator with a temporal 

administrator rights. When you start to run the SPM simulator, right click the simulator icon on the 

desktop, then select "Run as Administrator". The other way is to copy a sample project. Double click 

the simulator icon and start the SPM simulator in the usual way. Then load a sample project below 

"C:¥Program Files¥SpmSimulator¥SampleProject". In order to make a copy of the project, select 

[File]  [save as] from the menu bar. "Save project" dialog opens. Set a project name and a folder 

where the project file will be saved. Keep in mind to select the folder where you have a right to 

write or make a file; e.g. below "C:¥Users¥UserName".  

 

Troubles on simulation 
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Troubles on installation 

 

We introduce the error codes which may occur on installation, and how to fix them. 

 

Install error (Error code:0003) 

The information of the network connection may not be obtained. When you install the SPM 

simulator, your PC has to be connected to the internet. The installer checks a network information 

using an application "ipconfig.exe" attached to Windows system, but fails to obtain a normal 

connection information. 

At first, confirm a connection to the internet. If the connection has no problem and this error 

code still occurs, please advance to the next procedures. 

This error code may occur when the Path in the environment variable of Windows does not 

contain a path to the "ipconfig.exe". Please edit an environment variable according to the following 

procedures. 

Please open "System Properties" dialog as follows. [In case of Windows XP] Right click "My 

Computer" icon on your desktop or from the start menu, then select "properties". [In case of 

Windows 7] Click the start button in the lower left of the screen. Then right click the "Computer" 

and select "properties" from the pop-up menu to open the System control panel. Select "Advanced 

system settings" on the left side of the panel, then "System Properties" opens. 

Next, click "Advanced" tab on the "System Properties" dialog. Then click "Environment Variables" 

button to open "Environment Variables" dialog. Please be careful not to mistake from here. Select 

"Path" from the list of "System variables" (not from "User variables"), then click "Edit" button to 

open "Edit System Variable" dialog. Add values at "Variable value" form as follows. Set a cursor at 

the end of the form. Copy and paste the following whole line including the first semicolon. 

;%SystemRoot%;%SystemRoot%\System32;%SystemRoot%\System32\Wbem 

Click "OK" button to finish editing the system variable. Then click "OK" to reflect the environment 

variable. Finally click "OK" to close the "System Properties" dialog. Now the setting of the 

environment variable is completed. Please start the installer again. 

 

Troubles on installation 
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